2 %,
o B 3
o tode o
DAY %
W
/////”////

TR B B B R EEEEEREEREEREEEEEEERR!



SR B AR BRI T R R T R



(N %
o %
S Q) %,
2, 2.0, %
4 % % %,
Yo 70,0, %,
560, %% %
% %" v

VB E R R R RN NN RN NN .



First Edition (July 1988)

The iskewing parserspti dose ot crplr o B L T
country where such provisions are inconsistent with local
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INGLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer
of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This publication could include technical inaccuracies or typographical
errors. Ghanges are periodically made to the information herein;
these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s)
and/or the program(s) described in this publication at any time.

It

possible that this publication may contain reference to, or infor-
mation about, IBM products (machines and programs), programming,
or services that are not announced in your country. Such references
or information must not be construed to mean that IBM intends to
announce such IBM products, programming, or services in your
country.

Requests for technical information about IBM products should be
made to your IBM Authorized Dealer or your IBM Marketing Repre-
sentative.

© Copyright International Business Machines Corporation 1981, 1988.
Al rights reserved. No part of this publication may be reproduced or
distributed in any form or by any means without prior permission
writing from the International Business Machines Corporation.
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DOS 4.00 Library

§BE™

Getting Started with DOS 4.00

The first part of this book provides infor-
mation you need to install DOS 4.00 and
supplements the online information in
the SELECT program. The second part
introduces you to the DOS Shell

Using DOS 4.00

By using examples, this book explains
how to manage your information from
the command prompt, how to change the
configuration of your system, and how to
create and change batch files.

DOS 4.00 Command Reference

This book, an additional purchase item,
provides detailed information on the
commands used in DOS 4.00 and con-
tains tables relating tasks to these com-
mands.

DOS 4.00 Technical Reference and
Application Programming

‘This book, an additional purchase item,
s written for programmers who develop
applications for IBM Personal Gom-
puters and IBM Personal System/2®.

Personal System/2 s a registered trademark of the International Busi-

ness Machines Corporation.
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Preface

This book provides information you need to install DOS 4.00 and sup-
plements the online help information available to you in the SELECT
installation program. It also introduces you to the DOS Shell and has
detailed information on using its features.

The information is divided into the following chapters:

« Chapter 1 supplies diskette information and lists the key assign-
ments used in the SELECT installation program.

« Chapter 2 describes installation procedures for installing DOS
4.00 for both fixed disk and diskette-based systems.

* Chapter 3 introduces you to the DOS Shell and provides an inter
active tour, which explains its basic operations.

Chapter 4 describes some of the more advanced tasks possible in
the Shell.

« Chapter 5 provides information on customizing the Shell and
other installation information.

* Chapter 6 describes the FDISK utility.

Before you install DOS 4.00, you should be able to identify the
attached devices on your computer (printers, modems, and so on).
You also need to know your computer’s memory capacity, whether
Yyour computer has a fixed disk, and the kinds of diskettes it uses.
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Chapter 1. Before Installing DOS 4.00

The IBM Disk Operating System (DOS) makes it easier for you to
manage your information, your programs, and your system
resources. DOS 4.00 includes several enhancements over DOS 3.30.

The SELECT command is enhanced to be a full-screen utility
designed to help you install DOS 4.00 or replace a previous DOS
version. DOS 4.00 also includes National Language Support
enhancements and the DOS Shell, which offers menu-oriented access
to commonly used DOS commands.

DOS 4.00 is designed to support large (more than 32MB) media. It
should be remembered that previous versions of DOS do not recog-
nize partitions larger than 32MB nor files stored in those partitions.
(Refer to Chapter 6 for information on DOS partitions.)

DOS 4.00 Memory Requirements

For a diskette-only system or for a fixed disk system, a minimum
memory size of 256KB is required to install DOS 4.00.

After installation, to determine your system'’s used and free memory
and to get a list of allocated memory areas, free areas, and installed
programs, you can run the MEM command. Ways to use the MEM
command can be found in Using DOS 4.00.

The DOS Shell Startup Options

The DOS Shell can be installed with startup options that suit the
memory your system has or the memory you wish to allot to the
Shell.

1f you have a system with at least 360KB of memory, the Shell can be
installed in its entirety. If your system’s memory is less than 360KB,
o i you wish to use less memory for the Shell, you can choose
startup options to suit your needs. Refer to page 110 for the startup
options available for the Shell and three suggested startup configura-
tions, two of which are for systems with 256KB of memory.
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3.5-inch Drive Diskette Requirements

If you are installing DOS 4.0 to diskette and have a 720KB diskette
drive, you need:

The two 3.5-inch diskettes shipped with DOS 4.00 and
two new or blank 3.5-inch TMB diskettes. (The 1MB diskettes
format to 720KB for installation with a 720KB drive.)
If you are installing DOS 4.00 to diskette and have a 1.44MB diskette
drive, you need:
‘The two 3.5-inch diskettes shipped with DOS 4.00 and
one new or blank 3.5-inch 2MB diskette. (The 2MB diskette
formats to 1.44MB for installation with a 1.44MB drive.)

If you are installing DOS 4.00 to a fixed disk, you need:

The two 3.5-inch diskettes shipped with DOS 4.00 and
one new o blank 3.5-inch 1MB diskette or, if you have a 1.44MB
drive, one new or blank 3.5-inch 2MB diskette.

5.25-inch Drive Diskette Requirements
It you have a 5.25-inch diskette drive and you are installing DOS 4.00
o diskette, you need:

The five 5.25-inch 360KB DOS 4.00 diskettes and
four new or blank 5.25-inch 360KB diskettes.

f you are installing DOS 4.00 to a fixed disk, you need:

The five 5.25-Inch 360KB DOS 4.00 diskettes and
one new or blank 5.25-inch 360KB diskette.




3.5-inch Write-Protected Diskettes

Itis possible to format a diskette or write information to a diskette
unintentionally. For this reason, some diskettes are write-protected.
You can read information from write-protected diskettes, but you
cannot write information to them.

inch diskette contains a write-protect window in the lower
corner. When the window is open, the diskette is write-protected and
its information cannot be changed. If you close the window, by
sliding the plastic tab shut or by covering it with a piece of opaque
tape, information can be written to the diskette.

To avoid writing information to the diskettes you received with DOS
4.00, they must be write-protected. If the diskettes you received are
not write-protected, slide the tab so that the window is open. In this

/ay, you can install DOS 4.00 from these diskettes, but you cannot
unintentionally write something to them.

5.25-inch Write-Protected Diskettes

A 5.25-inch diskette may contain a write-protect notch on the side of
the diskette. If there is no notch, or if there is a notch and the notch is
covered with  tab o a piece of opaque tape, it is write-protected and
formation cannot be written to

If the DOS 4.00 diskettes you have are not write-protected, cover the
notch with a piece of opaque tape. In this way, you can install DOS
4.00 from these diskettes, but you cannot unintentionally write some-
thing to them.
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Inserting 3.5-inch Diskettes

As you install DOS 4.00, you are asked to insert diskettes into your
system. Follow this procedure:

1. Insert the diskette into the drive. The arrow side must be up and
the arrow must be pointing to the diskette drive.

2. Press gently on the outer edge of the diskette until it “clicks" and
drops into place.

To remove the diskette, press the disk eject button on the lower right
of the diskette d t remove the diskette when the in-use light
is on; this light indicates that the system unit is accessing information
from the diskette drive.

Inserting 5.25-inch Diskettes
As you install DOS 4.00, you are asked to insert diskettes into your
system. Follow this procedure:

1. Remove the diskette from its paper envelope.

2. Open the diskette drive door.

3. Gently insert the diskette into the drive; the label must be facing
up and the write-protect notch must be to the left.

then close the drive.

Make sure that the diskette is all the way
door.

To remove the diskette, open the diskette drive door and pull out the
diskette. Do not remove the diskette when the in-use light is on; this
light indicates that the system unit is accessing information from the
diskette drive.




SELECT Special Key Assignments

While you are installing DOS 4.00, you need to be aware of several
special functions that have been given to some of the keys on your
keyboard (Figure 1). A reminder of these key assignments is avail-
able to you online from any of the help panels when F1=Help
appears on your display.

Task Key
Move the cursor to the next choice. Tab

Move the cursor in the direction of the arrow. 1 or | or - or «

Proceed to the next step. Enter

Return to the previous screen. Information  Esc

typed on the current screen is not saved,

Scroll Help text information. PgUp or PgDn
Display online help information when avail-  F1

able.

End DOS 4.00 installation. F3

View key assignments while viewing help. Fo

Figure 1. SELECT Key Assignments

Responding to Error Messages

During installation, error messages may be displayed. Appendix A
lists explanations of installation error messages and the steps neces-
sary to recover from them. Explanations for error messages you may
receive after installation can be found in Appendix D of Using DOS
4.00.
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Chapter 2. Installing DOS 4.00

The DOS 4.00 package contains two 3.5-inch 720KB diskettes labeled
Install and Operating.

If you are using 5.25-inch 360KB DOS 4.00 diskettes, you have five
diskettes labeled Install, Select, Operating 1, Operating 2, and Oper-
ating 3.

To install DOS 4.00, whether it is a new installation or you are
replacing a previous version of DOS, you can let the SELECT
program make most of the installation decisions. SELECT sets up the
system so that it works ntly for most applications.

f you are replacing a previous version of DOS, SELECT installs DOS
4.00 without jeopardizing the files that you have created.

This chapter contains instructions for each of the following installa-
tion procedures (Figure 2). If you have afixed disk, installing to a
fixed disk is usually the installation choice.

Installation Procedure Page
Installing to diskette on a system with no fixed disk 9
Installing to diskette with a fixed disk system 13
Installing to a fixed disk 19
Installing to a fixed disk to coexist with another oper- 28
ating system

Defining larger partitions before installing to fixed disk 32

Figure 2. Installation Procedures

Warning: Unless you choose to install to a specified directory (one of
the choices when installing to a fixed disk), DOS 4.00 overwrites all
previous version DOS files, including read-only DOS files. Also, if
You install DOS 4.00, modify any .MEU files, and reinstall DOS 4.00,
the modified .MEU files are then overwritten.



During the SELECT installation process, the highlighted option on
each screen is the choice that SELECT makes for you. This high-
lighting is called the “selection cursor.” Press the Enter key to
accept this choice. To make a different choice, use the arrow keys (1
or 1) to move the selection cursor to a different option; then press
Enter. When you are asked to type something, it is shown in UPPER-
CASE letters. However, you can use uppercase or lowercase letters,
or both.

Installing to Systems with 0S/2™

On a system that has Operating System/2™ installed on the fixed
disk, DOS 4.00 can be installed to diskette and then started from
diskette. An alternative coexisting installation process s described
on page 28.

1f you choose to install DOS 4.00 to the entire fixed disk, SELECT
renames 0S/2's AUTOEXEC.BAT and CONFIG.SYS files to
AUTOEXEC.0S2 and CONFIG.0S2.

Operating System/2 and OS/2 are trademarks of the International Busi-
ness Machines Corporation.
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Installing DOS 4.00 to Diskette on a System with
No Fix

As you perform the install procedure, you are prompted when to
insert each diskette. The drive in a one-diskette drive system is
called drive A

1. Label your two blank 3.5-inch

iskettes Startup and Shell.

It you are installing with 5.25-inch 360KB diskettes, label your
four blank diskettes Startup, Shell, Working 1, and Working 2.

2. Make sure that the DOS 4.00 installation diskettes are

p diskettes
are on page 4)

. Insert the DOS 4.00 Install diskette in drive A.

4. Turn on your system. If your system is already on, press

Gtrl+Alt+ Del to restart your system.

Note: The + between key names means that the keys must be
pressed and held down in the order shown and released
together.

You see this screen. (If you are installing with 5.25-inch
diskettes, remove the Install diskette and insert the Select
diskette; then press Enter to see this screen.)

(€) Copyright 184 Corp. 1088
A rights reserved.

Press Enter (+) to continue or Esc to Cancel

5. Press Enter and follow the instructions as they are displayed.



The messages tell you what action is occurring and when to
insert diskettes. The selection cursor on each screen is on the
the choice that SELECT makes for you when you press the Enter
key. To make a different choice, use the arrow keys (1 or |) o
move the selection cursor to a different option; then press Enter.

Note: You have the opportunity to review the choices you make
during installation and those that SELECT makes for you.
u can either accept these choices or change them. If
you review your choices and want to change the Shell
parameters (startup options), refer to “Customizing the
DOS Shell with Startup Options” on page 110.

During the installation procedure, you see this screen:

Continuing Installation

SELECT w11 crete the folloing diskettes;
(You w11 need 2 blank 148 diskettes)

stTwp starting 005,
005 UeiTties
L starting St

Tore g bt ibtes

Label the blank diskettes as shown, and
then follow the display prompts.

It you are installing with 5.25-Inch diskettes, you are instructed to
label your four blank diskettes Startup, Shell, Working 1, and
Working 2

°

. Press Enter.

Insert the diskette identified on the screen; then press Enter to
continue installing DOS 4.00.

While you install DOS 4.00, you are prompted on the screen when to
insert a diskette and which diskette SELECT needs. You exchange
diskettes frequently, at irregular intervals, until the installation is
complete. The messages displayed tell you the activity taking place.
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If you are interrupted and wish to start over,
and press Ctrl+ Alt-+ Del to restart the Instal
first SELECT screen.

insert the Install diskette
ation procedure at the

When you complete installation, you see this screen:

Installation Complete
Installation of 18 005 4.00 is complete.

To start 005, place the STARTUP diskette in drive A
and press Cer1oAl el

To start the 005 Shell, place the SHELL diskette
in drive A, and press CtrlvAltadel.

TOR IOBMTION O TN THE O SHELL, PR TO
THE “GETTING STARTED WITH 005 4.00°

DOS 4.00 is successtully installed to your diskettes. Store the
diskettes that came with DOS 4.00 in a safe place.
To start DOS 4.00:
1. Remove diskettes.
2. Write-protect the diskettes you labeled during installation.
(Instructions on how to write-protect diskettes are on page 4.)
. To start DOS 4.00 with the DOS Shell, insert the Shell diskette in
drive A; then press Ctrl-+Alt+Del.

To start DOS 4.00 without the DOS Shell, insert the Startup
diskette in drive A; then press Ctrl-+Alt-+Del.

Note: For any error messages you may receive, refer to
Appendix D in Using DOS 4.00 for an explanation.

Utlities not resident on the Shell diskette are on the Startup

diskette.

4. Refer to Chapter 3, “Learning to Use the DOS Shell,” to learn
Wwhat a “shell” is and how to accomplish tasks using the DOS
Shell.



To start DOS 4.00 if you installed to 5.25-inch diskettes:

1. Remove diskettes.

2. Write-protect the diskettes you labeled during installation.
(Instructions on how to write-protect diskettes are on page 4.)

3. Insert the Startup diskette in drive A.
4. Press Ctrl +Alt+ Del to start DOS 4.00.
Note: For any error messages you may receive, refer to
Appendix D in Using DOS 4.00 for an explanation.
5. Remove the Startup diskette and insert the Shell diskette.
6. Type DOSSHELL at the command prompt; then press Enter to
start the DOS Shell.
The DOS Shell is displayed.
7. Refer to Chapter 3, “Learning to Use the DOS Shell,” to learn

what a “shell” is and how to accomplish tasks using the DOS
Shell.
Utilties not resident on the Shell diskette are on the Startup,
Working 1, and Working 2 diskettes.
To determine what resides on the diskettes created during installa-
tion, perform a DIR command on each diskette. (COMMAND.COM is
on the Startup diskette.) Information on using the DIR command and
all DOS commands is in Using DOS 4.00.
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Installing DOS 4.00 to Diskette with a Fixed Disk
System

It you have a fixed disk but want to install DOS 4.00 to diskette, use.
this procedure. You are prompted when to insert each diskette.

1 Lahel your diskettes. (Refer to your hardware documentation for
formation on the drive capacities on your system.)

If you are installing on a 1.44MB drive to  single diskette, label
your blank 2MB diskette Startup.

If you are installing on a 720KB drive to two diskettes, label your
blank diskettes Startup and Shell

If you are installing on a 360KB drive to four diskettes,
blank diskettes Startup, Shell, Working 1, and Working 2.

2. Make sure the DOS 4.00 installation diskettes are write-protected.
(Instructions on how to write-protect diskettes are on page 4.)

el your

Insert the DOS 4.00 Install diskette in drive A.

Turn on your system. If your system
Ctri+Alt-+ Del to restart your system

already on, press

Note: The + between key names means that the keys must be
pressed and held down in the order shown and released
together.



You see this screen. (If you are installing with 5.25-inch
diskettes, remove the Install diskette and insert the Select
diskette; then press Enter to see this screen.)

(€) Copyright 184 Corp. 1086,
A rights reserved.

press Enter (1) to continue or Esc to Cancel

5. Press Enter and follow the instructions as they are displayed.

The messages tell you what action is occurring and when to
insert diskettes. The selection cursor on each screen is on the

choice that SELECT makes for you when you press the Enter key.

To make a different choice, use the arrow keys (1 or |) to move
the selection cursor to a different option; then press Enter.
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During installation, you see the following screen:

Sellct Installation Orive

Choose the drive to instal 005 4.0 on:

Tter  EaeeCancal IR

Item 2, which Is for installing 2 diskette, may show an A or a B
on your system. talling to your fixed disk, go right to
“Installing DOS 4.00 to @ xed Diske an page 19.

6. Use the arrow key (1) to move the selection cursor to 2; then
press Enter.
The messages that follow tell you what action is ocourring and when
toinsert diskettes.

Note: You have the opportunity to review the choices you make
during installation and those that SELECT makes for you. You
can either accept these choices or change them. If you review
your choices and want to change the Shell parameters (startup
options), refer to “Customizing the DOS Shell with Startup
Options” on page 110.



you are Installing to a single diskette on a 1.44MB drive, when you
complete the installation, you see this screer

Installation Complete

Installation of 18 005 4.0 is complete.

lace the e STUTIP disatie Indrive A and
press Ciri+A1tiDe] to start 008

TOR ITORMTION O 11 THE U5 SHELL PR TO
THE “GETTING STARTED WITH 005 4.

DOS 4.00 is successfully installed to your diskette. Store the
diskettes that came with DOS 4.00 in a safe place.

To start DOS 4.00:
1. Remove diskettes.

2. Write-protect the diskette you labeled Startup. (Instructions on
how to write-protect diskettes are on page 4.)

Insert the Startup diskette in drive A.

Press Gtrl + Alt+ Del to start DOS 4.00.

Note: For any error messages you may receive, refer to
Appendix D in Using DOS 4.00 for an explanation.

5. Refer to Chapter 3, “Learning to Use the DOS Shell,” to learn

what a “shell” is and how to accomplish tasks using the DOS

shell
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It you are Installing to two 720KB diskettes, when you complete instal-
lation, you see this screen:

Installation Conplete
Installation of 184 00S 4.00 fs complete.

start 005, place the STARTUP diskette in drive &
i press CHIA el

To strt e 005 Sl lace the SHELL iskests
n driv A, and pres oML

08 IITATION O USNG THE 035 SHEL, WTER T0
THE "GETTING STARTED WITH 005 4.00°

DOS 4.00 is successfully installed to your diskettes. Store the
diskettes that came with DOS 4.00 in a safe place.
To start DOS 4.00:

1. Remove diskettes.

2. Write-protect the diskettes you labeled during installation.
(Instructions on how to write-protect diskettes are on page 4.)

. To start DOS 4.00 with the DOS Shell, insert the Shell diskette in
drive A; then press Ctrl-+Alt-+Del.
To start DOS 4.00 without the DOS Shell, insert the Startup
diskette in drive A; then press Ctrl-+Alt-+Del.

For any error messages you may receive, refer to
Appendix D in Using DOS 4.00 for an explanation.

Utilities not resident on the Shell diskette are on the Startup.
diskette.

»

Refer to Chapter 3, “Learning to Use the DOS Shell,” to learn
what a “shell” is and how to accomplish tasks using the DOS.
Shell,



To start DOS 4.00 if you installed to 5.25-inch diskettes:
1. Remove all diskettes.

2. Write-protect the diskettes you labeled during installation.
(Instructions on how to write-protect diskettes are on page 4.)

©

Insert the Startup diskette in drive A
Press Ctrl-+Alt+Del to start DOS 4.00.

»

Note: For any error messages you may receive, refer to
Appendix D in Using DOS 4.00 for an explanation.

Remove the Startup diskette; then insert the Shell diskette in
drive A.

°

Type DOSSHELL; then press Enter to start the DOS Shell.
The DOS Shell is displayed.

Refer to Chapter 3, “Learning to Use the DOS Shell” to learn what
a “shell” is and how to accomplish tasks using the DOS Shell.

Utilities not resident on the Shell diskette are on the Working 1,
Working 2, and Startup diskettes.

To determine what resides on the diskettes created during installa-
n, you can perform a DIR command on each diskett
(COMMAND.COM is on your Startup diskette.) Information on using
the DIR command and all DOS commands is in Using DOS 4.00.

X
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Installing DOS 4.00 to a Fixed Disk

If you have a previous version of DOS on your system and you want
to redefine your pa izes to larger than 32MB, refer to page 32
before beginning the fixed disk installation.

The installation procedures that follow are for installing DOS 4.00 to a
fixed disk in these ways

« Installing to a fixed disk that does not have a previous version of
nit.

+ Installing to a fixed disk that does have a previous version of DOS
onitin one of the following ways:

~ Updating all DOS files on the fixed disk.

— Copying only the non-system files to a specified directory.
(Ghoose this option if you have network consider orit
Yyou want to install DOS 4.00 to coexist with your existing
operating system. Refer to page 28 for instructions on
installing DOS 4.00 to coexist with another operating system.)

As you per'mm ma installation procedure, you are prompted when to
insert each dis}

1. Label your blank diskette Select Copy.

2 Make suelie Do olsekaicn duons 1o wme Dvotsctsd
di )

3. Insert the DOS 4.00 Install diskette in drive A.

4. Turn on your system. If your system is already on, press
Gtrl+Alt + Del to restart your system.
Note: The + between key names means that the keys must be
pressed and held down in the order shown and released
together.



You see this screen. (If you are installing with 5.25-inch
diskettes, remove the /nstall diskette and insert the Select

diskette; then press Enter to see this screen.)

(©) Conront, 1 Cors, 585
Fights reserved.

Press Enter (1) to continue or Esc to Cancel

(L
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5. Press Enter and follow the instructions as they are displayed.

You exchange diskettes several times during the installation pro-
cedure. The selection cursor on each screen is on the choice that
SELECT makes for you when you press the Enter key. To make a

different choice, use the arrow keys (1 or |) to move the selection

cursor to a different option; then press Enter.
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During installation, you see the following screen:

Sellect Installation Orive

Choose the drive to fnstall 005 on:
T

2k

Toter EacCancal TS

Item 2, which is for Installing to diskette, may show an A or a B
on your system.

°

Choose 1; then press Enter.
You see this screen:

Speciy 005 Location

Yo o S O ity sl ) € e
directory

005 Directory c\os 1

To select option 1 below, press Enter. To cha
Ghtion, press th tah ke MaNIight your chaics and then
press Enter.

1. Update al1 005 files on fixed disk

2. Copy non-systen files to directory specified

Trier EeesCancel  Fiheln

7. To update all DOS files on your fixed disk and to accept “DOS" as
the name of the directory in which to install DOS 4.00, press
Enter.




Updating all DOS files on the fixed disk is generally the choice
here, and it is the choice that SELECT makes for you when you
press Enter.

Follow the Instructions on the screen to change the name of the
directory and/or to select option 2.

8. Continue installation as directed on the screen.

Note: You have the opportunity to review the choices you make
during installation and those that SELECT makes for you. You
can either accept these cholces or change them. If you review
your choices and want to change the Shell parameters (startup
options), refer to “Customizing the DOS Shell with Startup
Options” on page 110.

You can choose to make decisions in partitioning your fixed
disk or let SELECT do it for you. If you choose to make your
own partitioning decisions, refer to Chapter 6, “Partitioning
Your Fixed Disk.”

1 you Installed to a fixed disk that does not have a previous version of

DOS on I, start DOS 4.00 by following these steps:
1. Remove diskettes.
2. Press Ctrl+Alt+Del to start DOS 4.00.

Note: For any error messages you may receive, refer to
Appendix D in Using DOS 4.00 for an explanation.

The DOS Shell is displayed.

3. Refer to Chapter 3, “Learning to Use the DOS Shell," to learn
what a “shell” is and how to accomplish tasks using the DOS
Shell.

DOS 4.00 is now installed on your fixed disk and you can store the
diskettes that came with DOS 4.00 in a safe place.
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It you Installed to a ﬂnd disk that has a previous version of DOS and
all

you chose to Ins

entire fixed disk, you see this screen:

Instalation of 18 005 4.00 {s complete.

The files AUTOBXEC.400 and COVFIG.400 have been
copted to your fixed disk. The files contain the
aptions selected for 00S 4.00.

3

book for_ information on updating these files.

IR IHORATION O SN THE 00 SYEL, ETER TO
THE *GETTING STARTED WITH 005 4.60° 800K,

Resove a1l diskettes. Press Cirlvltide] to start 005

To start DOS 4.00:

-

Remove all diskettes.

. Press Ctrl-+Alt+Del to start DOS 4.00.

Note: For any error messages you may receive, refer to

Appendix D in Using DOS 4.0 for an explanation.

. Update your AUTOEXEC.BAT and CONFIG.SYS files. This proce-

dure is described in *Updating the CONFIG.SYS and
AUTOEXEC.BAT Files.”

Refer to Chapter 3, “Learning to Use the DOS Shell,” to learn
what a “shell” is and how to accomplish tasks using the DOS
Shell.

DOS 4.00 is now installed on your fixed disk and you can store the
diskettes that came with DOS 4.0 in a safe place.



1 you Installed to a fixed disk that has a previous version of DOS and
chose 1o copy non-system files to directory specified, you see this
screen:

Installation Complete
Installation of 18 005 4.00 is complete.

The f11es AUTGEKEC.400 and CONFIG.400 have been
copted to your fixed disk. These files reflect
the options selected for 005 4

To st the ntions slected
lote Yo TGN wd CNFIBSYS
Fles

2. Copy 005 4.

systen files to drive C
REFER T0 THE GETTING STARTED WITH 005 4.00° B00K
FOR INFORMATION ON UPOATING THESE FILES AD ON
USING THE D05 SHELL

Resove 11 diskettes. Press CtrlsnItsDel to start 005,

DOS 4.00 is now installed on your fixed disk in the directory you spec-
ified.

1. Remove the DOS 4.00 diskettes from your system.

2. Store them in a safe place.

If you want to start your system using DOS 4.00, the AUTOEXEG.400
and CONFIG. 400 files that were created by SELECT need to be
updated and the DOS 4.00 system files must be copied to drive C.
These procedures follow.

Updating the CONFIG.SYS and AUTOEXEC.BAT Files

A CONFIG.SYS file contains commands that set up your system to
work in a certain way. Each time you start your system, DOS.
searches for a CONFIG.SYS file and, f it finds one, uses the com-
mands contained there when setting up your system. After searching
for the CONFIG.SYS file, DOS searches for an AUTOEXEC.BAT file. If
DOS finds an AUTOEXEC.BAT file, it uses the commands there to
further define the way it starts your system.

During installation, SELECT checks your system for a CONFIG.SYS
file and an AUTOEXEC.BAT file. If either or both of these files exist
on your system, rather than overwriting these two existing files,

2
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SELECT creates a CONFIG.400 file and an AUTOEXEC.400 file. For
your system to use the configuration that SELECT has created in
these new files, they need to be renamed. If there are commands in
the existing CONFIG.SYS file and AUTOEXEC.BAT file that you want
to maintain, you also need to update these new files to contain these
commands before you rename them.

The following is an example of what may be in the CONFIG.400 file
that SELECT creates:

BREAK=ON

BUFFERS=20

FILE

LASTORIVE

S\COMMAND. COM /P /E:256
ANSI.SYS

The following is an example of what may be in the AUTOEXEC.400 file
that SELECT creates:

GECHO OFF
SET COMSP

\DOS\ COMMAND . COM.

To update and rename the AUTOEXEC.400 and CONFIG.400 files that
SELECT creates, follow these steps:

. Remove all diskettes from your system; then press Ctrl-+Alt-+Del
10 reach the C> prompt.

. Using an editor such as EDLIN, enter from the CONFIG.SYS file to
the CONFIG.400 file any commands that you want to maintain.
Instructions on using EDLIN are in Using DOS 4.00.

Exit the editor.
4. Do either of the following:

Rename your CONFIG.SYS file, or
erase your CONFIG.SYS file.



Rename the CONFIG.400 file to CONFIG.SYS.

o«

. Using an editor, enter any commands that you want to retain from

the AUTOEXEC.BAT file to the AUTOEXEC.400 file.

Note: If you have installed the Shell, the DOSSHELL command
must remain as the last command in your AUTOEXEC.400
file.

Exit the editor.

o

e

. Do either of the following:

Rename your AUTOEXEC.BAT file, or
erase your AUTOEXEC.BAT file.

Rename the AUTOEXEC. 400 file to AUTOEXEC.BAT.

Press Gtrl-+Alt+Del to start DOS 4.00.

Note: For any error messages you may recaive, refer to
Appendix D in Using DOS 4.00 for an explanation.

The DOS Shell is displayed.

Refer to Chapter 3, "Learning to Use the DOS Shell,” to learn

what a “shell” is and how to accomplish tasks using the DOS

Shell.

Copying System Files to Drive C
Follow these steps to copy system files to drive C. This is necessary
if you want to start your system in DOS 4.00 and if, during installation,
you chose to copy non-system files to a directory that you specified
on your fixed disk.

Insert the Install diskette in drive A.

2. Tur on your system. If your system is already on, press
Ctrl-+Alt+Del to restart your system.

Press Esc; then press F3. Your system displays the A> prompt.

It installing with 360KB 5.25-inch diskettes, press Esc. Your
system displays the A> prompt.

IS

Atthe A> prompt, type:
SYS C:

. Press Enter.
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6. To copy COMMAND.COM to drive C:
Atthe A> prompt, type:
0PY COMMAND.COM C
Press Enter.

(Instead of copying COMMAND.COM to drive C, if you prefer, you
can copy the SHELL = statement in the CONFIG.400 file to the
CONFIG.SYS file.)

7. Remove the Install diskette.
8. Press Ctrl-+Alt+Del to start DOS 4.00.



Installing DOS 4.00 to a Fixed Disk to Coexist with
Another Operating System

Installing DOS 4.00 to diskette, as described on page 13, is one way to
use DOS 4,00 on a system that has Operating System/2 (or any other
operating system) installed on the fixed disk.

An alternative to installing to diskette is to install DOS 4.00 to your
fixed disk, in @ manner which allows DOS 4.00 to coexist with the
existing operating system, and start DOS 4.00 from diskette. The
requirements before beginning this procedure folloy

The two 3.5-inch 720KB installation diskettes shipped with DOS
4.00 o the five 5.25-inch 360KB DOS 4.00 installation diskettes

One new or blank diskette (the same media as your drive A)
0872 (or another operating system) installed on your fixed disk.

When this installation procedure is complete, you can start DOS 4.00
from the diskette that you create during installation; then you can
remove the Startup diskette from drive A and operate DOS 4.00 from
the fixed disk.

1. Label your blank diskette Select Copy.

2. Insert the DOS 4.00 Install diskette in drive A.

3. Turn on your system.
It your system is already on, press Ctrl+Alt+ Del to restart your
system.
Note: The + between key names means that the keys must be

pressed and held down in the order shown and released
together.




You see the following screen. (If you are installing whh 5 25-inch
diskettes, remove the /nstall diskette and insert the
diskette; then press Enter to see this screen.)

© Cprion. 19 cors, 158,
1 rights

Press Enter (=) to continue or Esc to Cancel

4. Press Enter and follow the instructions as they are displayed.

The messages tell you what action is occurring and when to
insert diskettes. The selection cursor on each screen is on the
choice that SELEGT makes for you when you press the Enter key.

make a different choice, use the arrow keys (1 or |) to move
the selection cursor o a different option; then press Enter.



During installation, you see the following screen:

Select Installation Orive

Chose the drive to install 005 on:

Tter  EsceCancel iR

on your system.

Choose 1; then press Enter

The following is displayed:

Item 2, which s for installing to diskette, may show an A or a B

Specify 005 Location

You can accept the 005 directory nane shown or type a nex
divectory nane.

00S Directory - . .

To select option 1 below, press Enter. To change your
option, press the tab key, highlght your choice and then
press Enter.

1. Update all 00 files on fixed disk

2. Copy non-systen files to directory spectfled

e Eacetancel  FIRTp.

The cursor on this screen is at the entry field for the directory
name.

N
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12,
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Do either of the following:

Press the tab key to accept “DOS"” as the name of the direc-
tory in which to install DOS 4.00, or

Type in a new name for the directory; then press the tab key.
Press the arrow key (1) to move the selection cursor to option 2.

. Press Enter.

Continue installation as directed on the screen.
Note

You have the opportunity to review the choices you make
during installation and those that SELECT makes for you.
You can either accept these choices or change them. If
you review your choices and want to change the Shell
parameters (startup options), refer to “Customizing the
DOS Shell with Startup Options” on page 110.

When you complete installation, you see this screen:

Installation Conplete.
Installation of 184 005 4.00 is complete.
The ff1es AITOELEC.400 and CONFIG.400 have been

copted to your fixed disk. These files reflect
the options selected for 005 4.00.

To ot e o e o B8 a0
Uit your ATOBEE AT ard CONIGS15

2 Copy 0 .00 system Fies to drive €
REFER 70 THE "GETTING STARTED WITH 005 4.00° 800K
FOR_INFORMATION ON UFDATING THESE FILES AND O
USING THE D05 SHELL

Renove a1l diskettes. Press CtrlonltsDel to start 005,

Remove the Operating diskette.

. Insert the Install diskette in drive A.

Press Ctrl+Alt-+Del to restart your system.
Press Esc; then press F3 to exit SELECT.

f you are installing with 5.25-inch 360KB diskettes, press Esc to
exit SELECT.

Change the name of the Select Copy diskette to Startup.



15. Atthe prompt (A>) type:

FORMAT A: /S

The DOS FORMAT utility is started. (For more information on the

FORMAT command, see Using DOS 4.00.)
When asked to insert a diskette, insert the Startup diskette.
When asked for a volume label, type any name you want, up
to eleven characters long. (A suggestion is STARTUP.) Then
press Enter.
When asked if you are going to format another diskette, type
N (no); then press Enter.

To copy the AUTOEXEG.400 and CONFIG.400 files created by
SELECT to your Startup diskette, enter:

COPY C:\*.400

To rename CONFIG.400, enter:
RENAME CONFIG.400 CONFIG. SYS

To rename AUTOEXEC.400, enter:
RENAME AUTOEXEC. 400 AUTOEXEC.BAT

. Press Ctrl-+Alt+Del to start DOS 4.00.

Note: For any error messages you may receiv

refer
Appendix D in Using DOS 4.00 for an ekpllnahon j

The DOS Shell is displayed.

The Startup diskette can be removed after system startup. It must
be used each time you want to start DOS 4.00.

8

Refer to Chapter 3, “Learning to Use the DOS Shell," to learn
what a “shell” is and how to accomplish tasks using the DOS
Shell.

Mmoo om o M oM

Defining Larger Partitions

If you are installing to a system with partitions defined at 32MB or
smaller and you want to create larger partitions, you must back up
your fixed disk and remove the current partitions before installing
DOS 4.00. To do this:

1. Insert the DOS 4.00 Install diskette in drive A.

™
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Turn on your system. Ifitis already on, press Ctri-+Alt+Del to
restart your system.

. Press Esc; then press F3. Your system displays the A> prompt.

I installing with 360KB 5.25-inch diskettes, press Esc. Your
system displays the A> prompt.

Remove the Install diskette.

Insert the DOS 4.00 Operating diskette in drive A.
If installing with 360KB 5.25-inch diskettes, insert the DOS 4.00
Select diskette in drive A

. Define a path to the FORMAT command on your fixed disk. For
example:

D05

. Use the BACKUP command to back up all the partitions (drives)

on the fixed disk you want to repartition,

BACKUP automatically formats the target diskette if it is not
already formatted. When the format is completed, you are asked
if you want to format another diskette. Type N (no) to continue
with BACKUP. After BACKUP fills a diskette, you are prompted to
insert another diskette. Refer to Using DOS 4.00 for complete
instructions on using the BACKUP command.

When the command is completed, your system again displays the
A> prompt.

Remove the diskette from drive A.
Insert the Install diskette in drive A.

.. Use the FDISK utility to partition your fixed disk to the new parti-

tion sizes you want. Refer to Chapter 6 of this book for
instructions on using FDISK.

Atthe completion of FDISK, you are instructed to restart your
system. Press any key when ready.

Atthe SELECT screen, press Esc; then press F3. Your system
displays the A> prompt.

It installing with 360KB 5.25-inch diskettes, press Esc. Your
system displays the A> prompt.




. Use the FORMAT command to format the drives you created
during FDISK. Refer to Using DOS 4.00 for instructions on using
the FORMAT command.

Remove the Install diskette.

Insert the Operating diskette in drive A.

I installing with 360KB 5.25-inch diskettes, insert the Select
diskette in drive A.

Restore each backed-up partition using the RESTORE command.

Refer to Using DOS 4.00 for instructions on using the RESTORE
command.

Install DOS 4.00.
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IBMCACHE Command Considerations

If you are installing DOS 4.00 on a PS/2™ and plan to use the IBM
Disk Cache device driver shipped on the reference diskette, set the
BUFFERS statement in the CONFIG.SYS file to BUFFERS=3.

Command Prompt

DOS 4.00 and the DOS Shell are installed in a directory that is created
during the SELECT installation program. f the name of the directory
was not changed during installation, it is the DOS directory. If DOS
4.00 was installed to the fixed disk, the command prompt indicates
this by showing C as the drive and DOS as the directory:

Changing the Default Drive

islstocth eoiceftnsis DO prom el e dntuk e e
searches the default drive to find any commands or filenames that
you type.

1f you start DOS from a fixed Disk, C is the default drive. If you start
DOS from a diskette, A is the default drive. If you want to access
information in another drive, you can change the default drive by
typing the new drive letter followed by a colon. For example:

> (original prompt)

C (new drive designation)
Press Enter

A:\> (new prompt)

Now A is the default drive.

PS/2 is a trademark of the International Business Machines Corporation.

35
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Chapter 3. Learning to Use the DOS Shell

The DOS Shell is designed to make it easier to use DOS functions and
to help you select and run your application programs. Itis called a
“shell” because it surrounds DOS, covering the details of the disk
operating system.

This chapter takes you on a “tour” of many of the basic Shell func-
tions, showing you how the Shell works. The next chapter describes
some of the advanced tasks possible in the Shell. By pressing the F1
key, online Help is available throughout the Shell on all entry fields
and selectable items. The DOS Shell Reference Card shows the
details of the Shell, including Start Programs, the File System, and
key assignments.

“This tour will show you how the Shell works so that you can get
started on your work as quickly as possible. Start the tour at the
beginning and work your way through to the end. If you are pressed
for time, there are “side trips” that you can skip and come back to
later. Learning how to exit the Shell is the first activity on the tour
agenda. The tour is divided into four sections:

* Introducing the DOS Shell
Exiting and Restarting the Shell
Exploring Start Programs
Exploring the File System

Along the way, you see how to use online Help, select and deselect
files, change directories, select a display format, and change the
colors of the Shell. You will be able to set the date and time; create,
rename, and delete a directory; and find, copy and delete a file.

The activities necessary to complete a task are numbered. When you
are asked to type something, it is shown in UPPERCASE letters;
however, you can use uppercase or lowercase letters, or both

During this tour, you are asked to use the PgUp, PgDn, and arrow
keys. If these keys do not work on your keyboard, press the NumLock
ey.



Introducing the DOS Shell

The DOS Shell makes it possible for you to complete common DOS.
tasks by selecting options from a list instead of entering commands
for these tasks at the command prompt. Gommon DOS functions are
available to you in the Shell in an easy-to-use format. The Shell pro-
vides easy access to the command prompt for any tasks you want to
complete from there.

Turn On Your System
If your system is already on, press Ctrl + Alt+ Del to start DOS 4.00
and view the first Shell screen.

The + between key names means that the keys must be
pressed and held down in the order shown and released
together.

Start Programs is the first screen you see in the Shell:

30188 Start prograss 3:30 .
Program  Growp  Exit | Fishelp.

t an iten, use the up and down arrovs.
To start 8 progran or d1splay a ew aroup, press Entr.

ronpt

005 Ues1i

Flowhetions Shife4F9-Camand promt

The screen shown on your system may look different from the one
pictured here. There are two display modes in the Shell: text and
graphics. Throughout this book, the Shell is pictured in text mode,

The screen displayed is titled Start Programs. From here you can
start programs, change the items in the Main Group, display a new.
group, change the colors of the Shell, and reach the command
prompt. File System presents you with an area of activity where you
can manage your directories and files.

5
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The Main Group is the primary listing of the items in the Shell. The
Main Group can contain programs or groups. A subgroup can contain
only programs. These group arrangements are discussed in the tour
and in more detail in Chapter 4.

The figure on page 40 is an outline of the Shell and shows you the
areas of activities and how to reach them. Many of these activities.
are explored in this tour.

Mouse and Keyboard Information
The Shell is designed to work with a keyboard, a mouse, or both.
Keyboard information necessary to complete this tour is contained in
the tour directions.

For information on using a mouse, (and the scroll bar, which is part of
the Shell in graphics mode) plus additional information on keyboard
operation, refer to “Mouse and Keyboard Operation” on page 76.




This figure shows the paths to the functions that are available to you
in the DOS Shell

Start Programs.

[

Ext el

D e

DOS wnitis. ..
I~ Set Date and Time
Disk Copy

od Disk
[~ Restore Fixed Disk

Change Colors
Command Prompt

File System

==

e el L

director
L show information

Figure 3. Available Functions in the DOS Shell
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Exiting and Restarting the Shell

You can exit the Shell from Start Programs in two ways: You can
press F3 or you can select Exit at the action bar, and then select Exit
Shell F3 from the pull-down that follows.

The action bar contains keywords that, when selected, cause a
group of actions or additional keywords to appear in a
pull-down. A pull-down is a list of selections that follows after
you select one of the items on the action bar. To exita
pull-down without making a selection from the pull-down items,
press the Esc key, or with the mouse, click outside the
pull-down.

To begin the tour, follow these steps to exit the Shell to the DOS
prompt and then restart the Shell:

1. Press F3. You see the DOS command prompt on your screen:

ci\oos>

This command prompt shows C as the drive and DOS as the
directory. Your command prompt may be different, depending on
the decisions made when DOS 4.00 was installed.

2. Atthe prompt, type:
0SSHEL

3. Press Enter to restart the Shell.



You can exit the Shell at any time during the tour. If a help
message or an error message is displayed, first press Esc; then
press F3 to exit the Shell. If you are in the File System, press F3
to exit the File System; then press F3 again to exit the Shell

You are now back at the first Shell screen.

Exploring Start Programs
This figure shows the different parts of Start Programs.

- | B p

Group Contents

Action Bar

Display Title

Group Title.

St comns st

The two main parts of Start Programs are the action bar and the
group area. As you go through this tour, you will see that there can
be different group titles, but the display title remains Start Programs.

The three items on the action bar (Program, Group, and Exit) are
explored later in the tour.

Press the F10 key.

Note that Program on the action bar is now highlighted. Pressing

the F10 key always moves the salaction cursor to and from the

action bar. “Highlighting” is the method used in the Shell to in

cate an item or an area of .cﬂvny “This highlighting is called the
“selection cursor.

Press the arrow key (- or «) several times.

The selection cursor moves to the various items on the action
bar. (If your arrow keys are not active, press the NumLock key.)

~
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3. Continue pressing the arrow key until the selection cursor is
again on Program.

Online Help

Online help s always available to you in the Shell. By pressing the
played for the entry field or the item highlighted

also available for all error mes-

1. Press the F1 key now to view the Help for the Program item.

‘The following is displayed:

o0 Start prograns. 3:30
Program  Growp  Exit | Fisherp.

& an iten, use the up and down arrows.
LT S e

Tle Syst
Change Colors Progran
005 Uti1§tfes..| Select this action to start, add, change
copy, or delete a progran. You must place
the selection cursor on the progran title
want to work with before you select
this action.
EsceCancel Flshelp Fllsindex Fskers
Fo-hetsons Shifesro~Comand Prompt

This Help for Program is similar to the Help information that is

available o you at any time. You can press the F1 key for help

with all entry fields and selectable items.

The keys listed at the bottom of this Help panel are present on all

Help panels:

Esc=Cancel Returns you to the first Help panel; from the first
help panel, lets you cancel Help.

Fi

lelp  Shows you how the Help function works in the Shell.
Fli=index Shows you an index of the Help that is available in
ell

F9=Keys  Shows you the keys that have special functions in
hell.



2. Press F11 to see the Help index.

The Help index first shows important topics, and then an alpha-
betic st of the Shell Help.

Note: If you do not have a key on your keyboard defined as F11,
press and hold the Alt key, then press the F1 key.

o1-01-88 start prograns 330 m

Progran Growp Exit | F1eteln
To select an iten, use the up and down arrows.

To start o progran or display a new group, press Enter.

Comand prompt

File Systen
Change Colors Indexed Help Selections
005 Utilities.. Hore:
Introduction
Selecting Instructions
rt Prograss Instructions
File Systen Instructions
Keyboard Instructions
EsceCancel Flhelp Fll=index Foekeys
Floctions Shifeero-Comand prompt

The selection cursor is on Introduction.

©

. Press Enter to view the Introduction.
The first panel of the Shell introduction looks like this:

Introduction
tetcome to the 105 4.00 el
Use the
el

In general, use the Pl and Podn

EsceCancel Flekelp Fli=index Fo=Keys

4. Read through the Introduction.

Note the instructions to use the PgUp and PgDn keys. Use those
keys now to see each page in the Introduction. The PgUp and
PgDn keys work in this fashion throughout the Shell when you
want to scroll a list or information. (If your PgUp and PgDn keys
are not active, press the NumLock key.)
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Side Trip to the Help Function Keys.

If you like, you can take time now to explore the other areas of
Help. To do this:

a. Press the F1 key to see how the Shell Help function works.
b. Press the F9 key to view a list of special key assignments.
c. Press Esc to return.

5. Press Esc to exit Help.

Exploring the Start Programs Action Bar

The Start Programs action bar has three items, Program, Group, and
Exit. Each action bar item has a pull-down. Follow these steps to
explore the functions available at the Start Programs action bar.

1. Use the arrow key (— or +) to move the selection cursor to
Program at the action bar. (If a Help panel is displayed, press Esc
to exit Help; then move the selection cursor to Program at the.
action bar.)

Press Enter or the down arrow key (1).
The following is displayed:

o018 Start prograns 3:30
Progran Grow  Bxit | Fioterp

select an iten, use the up and down
s oroaron o dispia  rw ar, press Enter.

Floshetions Shifts79=Comand Prompt

An ellipsis (...) after an item in any pull-down in the Shell means.
that a pop-up follows when you press Enter. When an ellipsis is
used in the Shell, it means that more information follows. An
asterisk () within an item means the item is not selectable. (In
graphics mode, the unselectable item is shaded or “blurred.”)




Note: A pop-up is used to request additional information con-
cerning an item in a pull-down.

3. Press the arrow key (
The items in the Group pull-down let you add, change, or dele
group item, or rearrange the order in which the items appear.
The ellipsis (...) following each item means that a pop-up follows,
requesting more information and guiding you through the activity.

4. Press the arrow key (~) again.
The items in the Exit pull-down let you exit the Shell or resume
Start Programs.

5. Continue pressing the arrow key to view these pull-downs as.
often as you want.

You can view the Help text available on each pull-down item by
pressing the arrow keys (1 or |) to select the item and then
pressing the F1 key. Press Esc to exit Help.

6. Press Esc to exit the pull-downs.

Exploring the Main Group
'You can have two levels of groups in the Shell. The Main Group is
the primary level and you can add programs or groups to the Main
Group. The programs you add to the Main Group can start from
there. Subgroups can contain only programs.

When you are ready to add items, there is more information in
Chapter 4.

Exploring DOS Utilities and Setting Date and Time
The Shell comes with several common utilities that you can access
directly from the Shell. When Dos Utilities... is started, you see a sub-
group by that name.
1. Press the F10 key if the selection cursor is not in the group con-
tents area.
2. Press the arrow key (| or 1) to place the selection cursor on DOS
Utilities

It you like, you can press F1 to view the Help for DOS Utilities...
Press Esc to exit Help.

o
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3. Press Enter to view the DOS Utilities... subgroup.

The DOS Utilties... subgroup is displayed and the selection
cursor is on the Set Date and Time item.

weoiss sart programs 5530
o Grow Exit | Aok

005 ueidites...
To select an iten, use the up and down arrors.
To start & program or display & new grow, press Enter.

Set Date and Tine
Disk Copy

Disk Compere
Backup Fixed Disk
Restare Fixed Disk

Flowhctions  Esc=Cancel  Shiftso-Comand Prompt

Each of the utilties listed in the DOS Utilties... subgroup, wh
started, is followed by a pop-up. With the exception of Set Date and
Time, they each have the most common parameters predefined. A
cursor appears at the entry field in each pop-up, giving you the

opportunity to accept the predefined parameters or enter new ones.

Following are instructions to set the date and time using the
the Shell. The other utilities, when chosen, work simi

Side Trip to Set the Date and Time
1f you want to skip setting the date and time, go right to “Changing the
Colors of the Shell” on page 49.



The date and time are shown on the top of the screen. By following
these steps, you can set the correct date and time in the Shell

1

B

Press Enter to start the Set Date and Time utility. You see the
following:

o3-01-88 Start prograss 3:30 pu
Progran Grow  Exit | Fiekep
005 Utilities...
To select an {ten, use the up and down a
To start a progran or display . nw areu, press Eter.

et e rd Tiw

Disk Con
Disk Conpr

Sackup Fined Disk Set Date and Tine Utility
Restare Fixed Disk

Format Enter new date 711177

[ T |

Huentergscecancel Fiehelp

Flowhctions  EsceCancel  ShiftsFo-Comand Prompt

‘The cursor is at the entry field of the first prompt.

. Enter the correct date, using the character shown in the pop-up to

separate month, day and year entries.
You can press the F1 key for more information about this entry
field.

Press Enter. The time entry field is displayed.
Enter the time in hours and minutes.

Use two digits for each entry. For example, 1:35 p.m. is entered
like this

Press F1 if you want more information about this entry field.

s Enter. You see a prompt telling you to press any key to
o6 Press shE Enllr key.

The DOS Utilities... subgroup is again displayed.

If date and time entry fields are again displayed, it means the
entries were made incorrectly. Reenter the date and time.

. Press Esc to return to the Main Group.

o
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Changing the Colors of the Shell
One item in the Main Group allows you to change the colors of your
Shell. Do that now by following these steps:

1. If you are in the DOS Ut
the Main Group.

ies... subgroup, press ESC to return to

2. Press the arrow key (1 or |) to move the selection cursor to
Change Colors.
I you like, you can press the F1 key to view the Help on this item.
Press Esc to exit the Change Colors Help.

©

. Press Enter to start Change Colors.

>

Press the arrow key (either « or ) to see the color selections
available.

Press Enter when you have made your choice, or press Esc to
leave the colors as they were.

The Shell returns to the Main Group displayed in the colors you
chose.

Exploring the Shell Command Prompt
By following these steps, you will see how you can reach the Shell
command prompt, use DOS commands, and return to your task at the
point where you left it.

Using the Shell command prompt differs from exiting to the DOS
prompt as illusirated at the beginning of this tour. From the DOS
Prompt, you restart the Shell. From the Shell prompt, you return to
the Shell at the point where you left it
1. Press the arrow key (1 or |) to move the selection cursor to
Command Prompt.

2. Press Enter.



The Shell command prompt looks like this:

Wnen ready to return to the 005 Shell, type EXIT then press enter.

i 03 verston .00
(©)co ermatioa] usess ahines Corp 1981, 1588
(O iomriom Mcresefs Cors 101

cooss

Note: You can press Shift+F9 and reach the Shell command
prompt at any point in the Shell. I an additional panel is
being displayed (for example, a Help panel), press Esc;
then press Shift-+F to reach this command prompt.

You can use all the DOS commands from this prompt. For
mation on DOS commands, refer to Using DOS 4.00.

Atthe prompt, type:
eIt
4. Press Enter.

You are returned to the Shell at the point where you left

Side Trip to Files and Directories

Switching to the File System is the next item on the tour. While
touring the File System, you will be working with files and directories.
1f you are familiar with the way to organize information on a system,
skip this side trip and go directly to “Switching to the File System” on
page 53.
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Information on a system is organized in directories. A directory is a
grouping of files containing related information. A fife is like a docu-
ment.

Jt helps to think of the root directory on your system as a file drawer,
a subdirectory as a division within that drawer, and a file as a file
folder within that division.

File

Root
Directory

When DOS 4.00 was installed on your computer, it copied some of its
files from the DOS 4.00 diskettes to the root directory. The root lists
all the directories.

Current Directory

Whichever directory you are using is called the current directory. If

You stay, for example, in the root directory, then the root () is your
rent directory. If DOS 4.00 was installed in the DOS directory,

when you are using the Shell, DOS is your current directory.




Directory Trees
A directory tree is  diagram of the directories on a system as they
branch out from the root. (In the File System portion of the Shell, one
of the areas is titled Directory Tree and diagrams the directories on
your system.) The following is an example of a directory tree:

—00S

SURDIR
L—suBDIR2

|—pavroLL

SUBDIRZ

—DIRS

Specitying Path Nams
When you want to access information on your system, you specify its
location, or path, in terms of:

The drive storing the information
‘The directory containing the information
‘The filename of the information.

For example, if you are at the C prompt and you want to speciy a file
named MYFILE which resides on drive A, you type and enter:
AMYFILE

It you are at the A prompt and you want to specify the EDITOR.CMD
file in the PAYROLL subdirectory on drive C, you type and enter:
C:\PAYROLL\EDITOR. CHD

W ©
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Switching 10 the File System
In the next section, you will create a directory and copy and delete a
file while exploring the File System. To get started, follow these
stops:
1. Press the arrow key (| or 1) to move the selection cursor to File
System.
When you press Enter, you switch to the File System portion of
the Shell.
2. Press Enter to switch to the File System.

After switching to the File System, you see t

o3-01-88 File systen
File Options Arrange Exit
AscC
=

Directory Tree More: . Wore: 4
- c. ozus a7 109 030188
Coos IWEI0 oW 0,831 03-01-88

1 o2 030188
COMMD LM 30812 030188
CoNFIGsvs 180 e30188
AUTOEREC BAT 2 eas

FlomActions i ftsFosComand Prospt

In the File System, the action bar has four items. The Exit item allows
You to return to the Main Group of Start Programs.
To switch back to Start Programs:

1. Press the F10 key if the selection cursor is not at the action bar.

2. Use the arrow key (~+)to move the selection cursor to Exit.

3. Press Enter. The selection cursor is on Exit File System.



4. Press Enter. The Start Programs screen is displayed.
To switch back to the File System:

5. Use the arrow key (1 or |) to move the selection cursor to File
System; then press Enter.

The File System is again displayed.

Exploring the File System
This figure shows you the different parts of the File System.

a a H nEQ

e s
8 Srif e it Action Ba

Directory Tree

Display Title
Drive Identifier

Path Area

File List

Fiocsion st rot

Filename Area

SpomEoEO@

In the File System, you can manage your files and directories, and
you can start a program from here, too. (For a complete diagram of
the activities that are possible with each action bar item, refer to the
figure on page 40.)

. Press the F10 key several times. Note that the selection cursor
moves to and from the action bar.

Press the tab key several times to move the the selection cursor
to the active parts of the File System.

As you move the selection cursor to the different areas, you can
press F1 to view the online Help for each area. Also, note the area
title for Directory Tree. Nextto the Directory Tree area is the file list
area.

bl
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Just above the file list is a designation showing which files are dis-
played. The *." are global characters, and these are discussed later
in this tour. Which files are displayed, and this designation, is deter-
mined by the entry in the Display options... pull-down. The Display
options...pull-down i discussed in *Sorting Files” and “Finding
Files.

Thers s mora informalion o dipleying lfesin *Expiorie s il
System Screen Arrangements” on page

Exploring the File System Action Bar

The File System action bar has four items, File, Options, Arrange, and
Exit. Each of the action bar items, when selected, displa

pull-down showing the tasks that can be performed by selecting that
item

. Press F10 to reach the action bar. The selection cursor is on Filg

Press Enter, or press the | key. The File pull-down s displayed.
Press the arrow key (). The Options pull-down is displayed.
Press the arrow key (~+). The Arrange pull-down Is displayed.

ERFSras

Press the arrow key (~+) to display the Exit pull-down.

Each of the items on the action bar is explored in the tour. (For a
more complete description of the File System, you can refer to
page 95.)

6. Press Esc to exit the pull-down.

Selecting and Deselecting All the Files

The Shell lets you select all the files in the current directory at one
time, and also lets you deselect all the files at one time. Follow these
steps to learn how this is done.

Selecting all the Files

1. If the selection cursor is not at the action bar, press F10. The
selection cursor is on File,



2. Press Enter. The File pull-down is mspruyeu and it shows you
the tasks you can perform by selectin

03-01-88 File systen 3:30 pn
File Options Arrange  Exit | Fisketp
“pen (start)...
arint..
Wore: 4 P Wore: &
el con 0.8 630188
Imoos lcon 3012 630188
0o 39812 03-01-88
CONFIG_SYS 03-01-88
ATOENEC. 84T 127 ol

Create directary...
Select all
Deserect all

FleActions  ShiftsFo-Comand Promot.

The steps that follow describe how to select and deselect all the
files; however, each of the items in the File pull-down works simi-
larly, and pressing F1 displays Help for each item. You can see
by the ellipses that some of the items are followed by pop-ups.
Note: An asterisk (*) within an item means the item is not select-
able. (In graphics mode, the unselectable item is shaded
or “blurred.”)
For example, after selecting a file, Change attrbute... ets you
change t ossible choices are Hidden,
Req u—only and Archive. At each of these choices in the Change
attribute... pop-up, you can press F1 for explanations and help in
selecting it.

3. Press the arrow key (1) to move the selection cursor to Select all;
then press Enter.
Note that the screen changes and the selection symbol is now
front of each of the filenames, indicating that it is selected for
whatever activity you choose. (In graphics mode, the symbol in
front of a file is shaded when it is selected.)
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Deselecting all the Files

1. At the File System action bar, press the arrow key (- or «) to
move the selection cursor to File.

Press Enter. The File pull-down is displayed.

Press the arrow key (1) to move the selection cursor to Deselect
all; then press Enter.

Note that the screen changes and now there are no symbols pre-
ceding the filenames, which indicates that none of the files is
selected. (In graphics mode, the symbols in front of the files are
no longer shaded, indicating that none of the files is selected.)

Exploring File System Screen Arrangements
The screen presently being displayed shows you the fles in one

i You also can view the files in two different directories or
all the files in the specified drive.

1. Use the arrow key () to move the selection cursor to Arrange at
the action bar.
If the selection cursor is not at the action bar on your screen,
press F10; then move the selection cursor to Arrange.

. Press Enter. The selection cursor is on Single file list.

Press Enter agai

It an item i not selectable, in text mode, an asterisk (*) appears
within the item. In graphics mode, the unselectable item is
shaded or “blurred.”

f the screen format presently being displayed on your system is
Single file list, it is not selectable.

»

Press the arrow key (1) to move the selection cursor to Multiple
file list; then press Enter.



The screen changes and the multiple file st is shown:

030188 File Systen 3:30
File Options Arrange Bt | Fiotelp
ABC
i\
Directory Tree Hore:
- e\ owus 678
Coos 1810
ComaND _cov
AscC
Directory Tree More: + ‘
- ey ouus 678
Coos 1810 con
comaD oo

Flo-Actions  ShiftF3-Comand Promt

The multiple file list lets you view two directories on the same
drive or two directories on two different drives at the same time.
The display pictured shows the root (1) directory on drive C dis-
played twice.
To display a different directory on the same drive, change the
directory in one of the directory trees:

a. Tab to the Directory Tree area.

b. Use the arrow key (| and 1) to move the selection cursor to

the desired directory; then press Enter.

‘The files in the directory you selected are displayed in the file list
area.

The path area in a multiple file list display shows the path for the
e) directory (the directory in which you are working).
the root (1) directory is active in the top of th
screen and you change to the DOS directory in the bottom of the
screen, as you tab to the two areas, the path area changes to
reflect the currently active directory. The same is true if you
display two drives. The path area changes to reflect the currently
active drive.

To display directories on two drives, select another drive letter in
one of the drive identifier areas.

a. Tab to the drive identifier area.

oW oW oW oW oW NN
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b. Use the arrow key (~ or +-) to move the selection cursor to
the desired drive; then press Enter.
The drive you selected now replaces one of the displays. As you
press the tab key to move to the different areas of the screen, the
path area changes to reflect the currently active drive and direc-
tory.
Press F10 to reach the action bar.

@

6. Use the arrow key (~+) to move the selection cursor to Arrange at
the action bar; then press Enter.

7. Press the arrow key (1) to move the selection cursor to System
file list; then press Enter.
By selecting System file list, all the files on your drive can be
viewed. A file information panel is also shown. (There is an
explanation of this information on page 62, and it is also dis-
cussed later in this tour.)

Sorting Files
The Shell lets you sort o files so max msy are displayed in order of
name, extension, date, . The following steps guide
you in sorting yuur'llss hy extens (u ou want to sort all the files
on a drive, and you have not been muuwmg the tour, first select the
System file list item from the Arrange pull-down as described in
“Exploring File System Screen Arrangements.”)

1. Press F10 to reach the action bar.

2. Use the arrow key (~» or «) to move the selection cursor to
Options; then press Enter. The selection cursor is on Display
options.

Press Enter. Ths Dllplly options... pop-up is shown. The cursor
is at the Name: entry

. Press the tab key to reach the Sort by: list.

o a

Press the arrow key (1) to move the selection cursor to Extension;
then press Enter.

The file list area now lists the files on drive C sorted alphabet-
ically by extension.

1 you like, you can practice now sor
other sort options.

g the files by any of the



Finding Files

The Shell lets you find  file easily no matter where it is on your
drive. The System file list screen format (the format presently on
your screen) displays all the files in the specified drive (the drive you
have selected).

Follow these steps o find all the files with the .BAT extension, and
then to find and view a file called DOSSHELL BAT:

1. Press F10 to reach the action bar if the selection cursor is not
already on it.

2. Use the arrow key ( or «) to move the selection cursor to
Options; then press Enter. The selection cursor is on the Display.
options.. item.

3. Press Enter. The Display options... pop-up is shown. The cursor.
is at the Name: entry field.

4. Type over the asterisks:
*.BAT

Note: The * is a global character. When you use it in place of the
filename, all the files in the current directory with that
extension, regardless of their names, are listed in the list
of files.

The same is true if you use the global character in the
extension position. Typing FILENAME.* lists all the files
named FILENAME, regardess of their extensions.

This is a good way to find  file when you are unsure of
either the name or the extension. For more information
about global characters, see Using DOS 4.00.

@

Press Enter.

The File System is again displayed and the file list area now.
shows only the files on drive G with the .BAT extension. The
selection cursor is on Options at the action bar.

°

Press Enter to select Options.

¥
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7. Press Enter to select Display options... from the pull-down.
8. Type over the asterisks:
DOSSHELL.BAT
9. Press Enter.
The File System is displayed and the file list area now shows only the
DOSSHELL.BAT file.

Because you entered a specific filename (DOSSHELL.BAT) in Display
options..., the screen you see shows only the DOSSHELL.BAT file

ted in the file list area. The panel on the left has status information
about the DOSSHELL.BAT file.

03-01-88 File systen 3:30 m
File Options Arramge Exit | sty
A c

coos

e DOSSHELLLBAT  bore:
Nase : DOSSHELL.BAT DOSSHELL. 84T 307 03-01-88 3:30pm
Attr ;e

1,269,978
)

s
7,222,108
70,457,308

185

Flo-Actions  ShiftsFS-Comand Promt

In this display, the DOSSHELL.BAT file is shown in the DOS directory.
on drive C. (The file status numbers in the panel on the left of your
screen may be ditferent from those shown in the figure.)



Reading the File Status Information
The file status panel on the System file list screen can be read as

follows:

File

Selected

Directory

Disk

The name of the most recently highlighted file and its

attribute (a). The “a” attribute means archive. Other
pomble lllrlbums are “h” (hidden), “s" (system), and

ead only).
The nimber of selsoted flas, Icis 8 good idea o check
how many files are selected before you delete files.
The name and size of the directory containing the most
recently highlighted file. Also shown is the number of
files in that directo
The name and size of the disk, how much space the disk
still has available, the number of directories on the disk,
and the number of files presently resident on the disk.

Side Trip to View a File
Follow these steps to view the DOSSHELL.BAT file:

1. Press the tab key to move the selection cursor to the list of files.
Because of the previous steps in this tour, the DOSSHELL BAT
file is the only file presently listed in the file list.

Note:

The steps that follow to view the DOSSHELL.BAT file work
for any file. They also work whenever you select a file
from the file list, whether or not it is the only one there. If
there is more than one file displayed in the file list, use the
arrow keys (1 or |) to move the selection cursor to the file
You want to view; then press the spacebar to select it

Note that although the file in the file list, DOSSHELL.BAT, is high-
lighted, it is not selected.

Note the symbol at the beginning of the filename wher

Press the spacebar to select the DOSSHELL.BAT file.

selected. Also, the file information panel changes to indicate that
one file is now selected on drive C.

3. Press the F10 key to return the selection cursor to the action bar;

then press Enter to select i

4. Use the arrow key (}) to move the selection cursor to the View
item; then press Enter.

The DOSSHELL.BAT file is displayed.
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Note the action keys shown at the bottom of the screen. You can
press the F9 key to view hexadecimal (base 16 num-
bering system used by programmers). Press F9 again to return
to ASCII (readable text).

5. Press Esc to return to the File System display.

Note that the file that was previously selected is now deselected.
The Shell deselects files when you perform an operation on the,
selected files.
Because you replaced the *.* with a filename, only one file,
DOSSHELL.BAT, is listed in the file list. Replace e global charac-
ters () to have all the files listed.
Follow these steps to replace these characters:
1. Press F10 to reach the action bar.
2. Use the arrow key (~> or «-) to move the selection cursor to
Options; then press Enter.

©

. Press Enter to select Display options.... A pop-up is displayed.

>

Type " in the entry field. (Press the spacebar o Del key to elim-
inate any remaining characters.)

Press Enter.

Note that the list of files once again includes all the files on the

drive,

6. Use the arrow key (~ or +) to move the selection cursor to
Arrange; then press Enter.

7. Use the arrow key (1) to move the selection cursor to Single file

list; then press Enter

The root directory is now the current directory and the files in the

root directory are again listed.



Working with Director and Files

This part of the tour shows you how to create a directory, copy a file

into that directory, delete the file, rename the directory, and finally,

delete the directory that you made. These tasks are accomplished in

the File System. Al of the steps are accompanied with mmp\ete
tructions, and there are and I

can expect to see on your screen. (If you are unfamiliar wnn e DS

Shell, refer to the beginning of this chapter before starting these

tasks.)

The procedures outlined here for creating, renaming, and deleting a
directory also apply to subdirectories.

Creating a Directory

The first task is creating a directory. Because the selection symbol is
at the root (1) directory, this new directory will be a subdirectory of \.
Any directory you create is a subdirectory of the current (selected)
directory.
Follow these steps:

1. Press F10 to reach the action bar.

2. Move the selection cursor to File; then press Enter.

The File pull-down is displayed.

3. Move the selection cursor to Create directory...; then press Enter.
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5.

You see the following:

5-01-88 File Systen
File Options Arrange Exit

Direct Create Directory.

Coos New directory nane. . [ ]

ienter Escecancel Fiotelp

Flowictions  ShiftsF9-Comand Prompt

The cursor is at the entry field.

tory; then press Enter.

Type PRAGTICE in the entry field as the name of your new direc-

‘The directory you just made now shows in your directory tree:

o3-01

-8 File systen
File Gptions Arrange Exit

3:30 pn
| Fishelp.

Directory Tree More: 4

12346 678
RACTICE
s W Lcon

AUTOENEC. 84T

Flosictions  ShiftsosComand Prompt

Because you were in the \ directory when you made the new.

directory, PRACTICE is a subdirectory of \
Tab to the Directory Tree area.

6. Change the directory to the PRACTICE directory. (Move the

selection cursor to PRACTICE; then press Enter.)




: To change directories, the screen must be either a single
screen display, Single file list, or a multiple screen display,
Multiple file list. You can change your screen display by
selecting Arrange at the action bar.

The following is displayed:

File systen

00188
File options Arrange  Exit

a8 c

chpRacice

Directory Tree More

L\m
> [omacrice

. Hore:
Wo files in selectad directory

Fo-Actions  ShiftsF9-Comand Prompt

You are now in the PRACTICE directory. Because you have no
files in the PRACTICE directory, there are no files to list in the list
of files.

7. Press F10to return to the action bar.
Copying a File

When DOS 4.00 was installed on your system, a file named
012345.678 was installed in the root directory.

Follow these steps to copy the 012345.678 file to the PRACTICE
directory:

1. Deselect any previously selected files.
a. Press F10 to reach the action bar; then press Enter to select
File.
b. Move the selection cursor to Deselect all; then press Enter.

(1t you have no files selected, this item is unselectable. If this
is the case, press Esc to exit the File pull-down.)

Itis always a good idea to deselect all files before beginning a
copy or delete activity.
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2. Change the directory to the root (1) directory.

a. Tab to the Directory Tree.

b. If the root directory (G2) is not the current directory (the
current directory has the selection symbol in front of it), move
the selection cursor to C:\; then press Enter.

3. Select the file you want to copy.

a. Tab to the fle area.

b. Move the selection cursor to the file you want to copy; then
press the spacebar to select it. Note the symbol that appears
iin front of the file after it is selected. (In graphics mode, the
symbol becomes shaded.)

4. View Show Information... to check the file status.

a. Press F10 to reach the action bar.

b. Move the selection cursor to Options; then press Enter.

c. Move the selection cursor to Show Information...; then press
Enter.

The Show Information panel is displayed:

3018 File Systen 3:30 .
File Options Arrange  Exit | Fiskelp
Show Infornation
File
Name  :012345.678
Mtr i
P =
> o5 78 109 30188
0 oM w81 0018
IB00S [N 9,812 030188
K 0z 0018
conts srs 0 03018
AUTOBXEC. AT 2 ools

pe 005
Size 722,188
il : 70,916,205

3

esc-cancel _ F1-serp

FloActions S ftsrosComand Prompt

Note that the number of files shown as selected is 1. (If the
number of files shown as selected in the file information on your
sereen is more than 1, deselect all the selected files using the



©

procedure you learned earlier. Then restart this task at the first
step.)

The information on the Show Information panel is the same as
described for the information on the System file list screen
described on page 62.

. Press Esc to exit the Show Information panel

Move the selection cursor to File; then press Enter.

The File pull-down is displayed.

then press Enter.

Move the selection cursor to Copy.

The following panel is displayed:

Copy File
Fron:  [012345.678 >

Tor e\ >

+sgnter  EsceCancel  FleHelp

At the cursor, type C:\PRACTICE. The C: is the drive, the \ is the
root and PRACTICE is the name of the directory to which you
want to copy the file (the destination directory).

Press Enter.

The file you copled is now in the PRAGTICE directory and in the
root directory. (In this instance, because there was not a file of

the same name in the destination directory, no conﬂrmnlon s
necessary. If there is  file of the same name in the dest
directory, you are given an opportunity to stop the copy — 25
‘would write over the existing file —or confirm the writeover.)

. Change to the PRACTICE directory.

a. Tab to the Directory Tree.
b. Move the selection cursor to PRACTICE; then press Enter.
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The file list area now shows the 012345.678 file in the PRACTICE
directory:

w0188 [— 5130 pm
File totions rrange_exie | Fichety
Asc

camarice

Directory Tree More:t ¢

e\
- [wence
s

. Hore:
ouus .8 19 ool

FlvActions  ShiftsF3-Comand Prompt

aFile
Dele(mq afile is much like copying a file. First, the file must be.
selected; then, the file information can be checked:

1. Deselect all previously selected files.

a. Select File at the action bar; then press Enter.
b. Select Deselect all from the pull-down; then press Enter.

2. Tab to the list of files and select the 012345.678 file. (Press the
spacebar to select the file.)

3. Press F10 to reach the action bar.

4. Move the selection cursor to File; then press Enter.



The File pull-down is displaye

30188 File Systen 3:30 pm
File Options Arrange Exit | Fietelp
. Yor
oz 78 io9 o301

Renane..
Change attribute....
Vien

Create directory....
select all
Deselect alt

Fomictions  ShifesF9-Comand Prospt

5. Move the selection cursor to Delete...; then press Enter.

The following panel is displayed:

Delete File

Delete . . [012345.678

~Enter.

EsceCancel

Fltelp

The name of the file you selected to delete is named in this panel.

6. Press Enter.
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The following panel is displayed:

[ wnmrme |
beleting file: 0SB Lof 1
select an option.

1. Skip this file and continve
2. Delete this file

+efnter  EsceCancel  FlsHelp

The name of the file you chose to delete is named in this panel.

The selection cursor is on option 1. To skip this file, press Enter.
7. Move the selection cursor to option 2; then press Enter.

The file is deleted and the display again shows that there are no
files in the PRACTICE directory.

Renaming a Directory
Follow these steps to rename the PRACTICE directory:

1. Ghange to the PRACTICE directory. (The PRACTICE directory
should already be the current directory. If the selection symbol is
not in front of the PRACTICE directory, tab to the Directory tree
and move the selection cursor to the PRACTICE directory; then
press the Enter key to change to the PRACTICE directory.)

2. Press F10 to reach the action bar.

3. Move the selection cursor to File; then press Enter.

The File pull-down is displayed.

4. Move the selection cursor to Rename...; then press Enter.




The Rename pop-up is shown and the cursor is at the entry field:

Renase Directory
Current Name: PRACTICE

New nane. . [ 1

«enter  EsceCancel  Flebelp

Type MEMOS at the cursor.

Press Enter.

‘The PRACTICE directory is now renamed MEMOS, and your
screen looks like this:

File systen

030188 30 pu
File Options Arrange  Exit | Fishelp

e

Directory Tree Hore:t ¢ . Wore:
Mo files in selected directory

Flowhctions  ShifesF9-Comand prospt

Deleting a Directory
To delete the MEMOS directory, or any directory, follow these steps.
The selection cursor is on File at the action bar.

1. Press Enter. You see the

pull-down.
2. Move the sele

n cursor to Delete...; then press Enter.
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You see the following

Delete Directory
Directory: C:\MEWIS
Select an option.

1. Do ot delete this directory
2. Delete this directory

“ugnter EsceCancel FiHelp

This pop-up gives you the option to delete or not delete the direc-
tory that you have selected. The directory to be deleted is named
in the pop-up.

If the correct directory (in this case, “MEMOS") is identified in the
pop-up, do the following:

3. Move the selection cursor to item 2. Delete this directory.
4. Press Enter.
Not

In order for a directory to be deleted, it cannot contain files
or other directories. If you attempt to delete a directory
that is not empty, you see a message that access is denied.
If you see this message, press Esc to return to the action
bar, delete the contents of the directory, then delete the
directory.

The File System s displayed without the MEMOS directory.

This completes your tour. To return to Start Programs, move the
selection cursor to Exit and press Enter; then press Enter ag

In this chapter, you exited the Shell to the DOS prompt and were
introduced to the Shell command prompt; you had the opportunity to
switch between two portions of the Shell - Start Programs and File
Services —and you had an opportunity to complete several tasks.

The next chapter gives you information on doing more complex tasks,
along with other general information on the DOS Shell.
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Chapter 4. Using the DOS Shell for
Advanced Tasks

This chapter has general information about how the Shell works, plus
instructions on several complex tasks. To complete the tasks pre-
sented in this chapter, you should first understand Chapter 3,
“Learning to Use the DOS Shell,” starting on page 37.

When DOS 4.00 was installed on your system, the DOS Shell was
installed with various startup options that make it work in a certain
way. Refer to Ghapter 5 for information on changing these options.

Online Help Information

Comprehensive help information is available throughout the Shell.
Pressing the F1 key displays Help for entry fields, selectable items,
and error messages.

An entry field is any area in which you are asked to enter information,
A selectable item is an item you are asked to select from a list of
options. You can press F1 for information on any entry field or on the
item you have selected.

From any Help panel, you also can do the following:

* Press F1to learn how the Help function works.

* Press F1110 obtain an index of Help available in the Shell
There is a selectable list of instructions at the beginning of the
Help Index. Included in this list is an Introduction o the Shell and
instructions on Start Programs, the File System, selecting files,
and using a keyboard and a mouse. The rest of the Help Index is
listed alphabetically and offers help on all the entry fields and
selectable items.

* Press F9 to obtain help on the keys that have special functions.

When using a mouse, move the mouse pointer to F1=Help; then
press the selector button,




Entry Field Guidelines

An entry field is any area in which you are asked to enter information.

Itis defined by the characters surrounding it.

[ Brackets at each end of the entry field indicate that infor-
mation can be entered only inside those brackets.

[ >  Intextmode, acaret (>) atthe right of the entry field
means that the entry field is longer than is visible on the
screen. When you reach the caret, sither by entering
information or using the arrow key, the field scrolls to
display additional information and/or space available for
entering information. (When this is done, a caret also is
displayed at the left of the entry field indicating that there
»s additional information or space to the left that is not

le.) When all the remaining entry field is visible, the

endmg (or right) bracket is displayed.

In graphics mode, an arrow is used in place of the caret.

Mouse and Keyboard Operation

‘The DOS Shell s designed to be used with a mouse, a keyboard, or
both. f you have a mouse attached to your system, you see a mouse
pointer on your screen.

The mouse pointer in graphics mode looks like this
on your screen

The mouse pointer in text mode looks like this. ]

Selecting tems Using a Mou
To select items from any list using a mous
1. Move the mouse pointer over the item.
2. Click (press the selector button once) to select the item.

In the Main Group, to start a program or view a subgroup, place the
mouse pointer over the title of the item; then double-click (press the
selector button twice in quick succession).
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In the File System, to start a program, place the mouse pointer over
the name of the startable filename; then double-click (press the
selector button twice in quick succession).

Graphics Mode
oy Ifthe Shellis installed on your system in
graphics mode, a scroll bar appears on
[®] Line up the screen. The scroll bar is designed to
Page Up ‘work with a mouse. It s llustrated here
with the sections identified.
Siider
Box To see more items in a lst than can be
displayed at once, place the mouse
pointer over the arrow symbols in the
soroll bar; then press the selector button
to scroll through the list. If the selector
button s held, the list continues to
scroll. In addition, the arrows appear
shaded when no further scrolling in that
direction is possible.
[Z] Page Down
[ tine bown Or, place the mouse pointer over the
slider box, press and hold the selector
button, and drag the slider box up or
down. When you release the selector
button, the list scrolls to the position on
the list that s relative to the position of
the slider box.
Toxt Mode

I the Shell is installed on your system in text mode, place the mouse
pointer over the displayed arrow symbols (1 1); then press the
selector button to scroll through the list.



Selecting Hems Using a Keyboard
In Start Programs:

1. Press F10 to move between the action bar and the rest of the
screen.

2. Press 1, |, =, or « to move the selection cursor to an item; ther

* Either press Enter to start the program or view the subgroup
you selected, or press F10 to return to the action bar.
* On the action bar, press Enter.
In the File System:
1. Press F10 to move between the action bar and the rest of the
screen.

2. Use the tab key to move to the different areas.

3. Use the arrow keys (1, |, -+, or «) to move the selection cursor to
an item; t

« Toselect a drive or directory, press Enter.
* Toselectafile, press the spacebar.
« Tostarta program, press Enter.
Note that i there is an underlined or highlighted letter (mnemonic) in
a selectable item in the Shell, pressing that letter is another way to
select the item. If an asterisk (*) appears in an item, that item is not
selectable. In graphics mode, an unselectable item is shaded, or

Changing Directories

To change directories, tab to the Directory Tree and use the arrow
Key (1 or |) to move the selection cursor to the directory you want
then press Enter. Note that the symbol moves to the beginning of the
current directory.

To change directories using a mouse, place the mouse pointer over
the directory you want and click once. Note that the symbol is placed
at the beginning of the current directory.
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Selecting and Deselecting Files

In the Shell, before you can perform any task with files, the file or
files affected must be selected.

Using a Keyboard
To select a file, tab to the file list and use the arrow key (1 or |) to
move the selection cursor to the file you want; then press the
spacebar. In text mode, when a file is selected, a symbol is placed at
the beginning of the file. In graphics mode, the symbol at the begin-
ning of the file is shaded when the file is selected.

To select all the files listed in the file list:

1. Select File at the File System action bar.
2. Select Select all from the pull-down; then press Enter.

To deselect a file, press the spacebar.

To deselect all the files you have selected:

1. Select File at the File System action bar.
2. Select Deselect all from the pull-down; then press Enter.

Using a Mouse
To select a file, place the mouse pointer over the file; then click once.

To select all the files listed in the file list

1. Place the mouse pointer over File at the action bar; then click
once. The pull-down is displayed.

2. Place the mouse pointer over Select all; then click once.

To deselect a file, place the mouse pointer over the selected fle; then
click once.

To deselect all the files you have selected:

1. Place the mouse pointer over the File item at the action bar; then
click once. The pull-down is displayed.
2. Place the mouse pointer over Deselect all; then click once.
Note: Before beginning a task such as copying, deleting, or moving
files, itis always a goo to check the file information to
make sure that all files are deselected. To check the file infor-




mation, select Options at the action bar; then select Show infor-
mation... from the pull-down,

For information on selecting files across directories, refer to page.

Adding Items in the Main Group

While in Start Programs, you can start a program and add, change,
copy, delete, or reorder group items. The Main Group is the first
level of the group structure. That group, which is the first screen
when you start the Shell, is shown here:

03-01-88 start prograns 3:30 g
Program Growp  Exit | Fickels

yain
e L
To start a progran or display 8 new group, press Enter.

005 Utilities...

Floshctions Shifesro=Comand Prompt

The DOS Shell has two levels of groups and each group can have as
many as 16 items. The Main Group now lists four items:
Command Prompt, when chosen, takes you to the Shell command
prompt where you can use all the DOS commands.
File System works like a pregar title in that, when you select t,
the Shell presents an area of activity. In the File System, you can
manage your directories and fies.

Change Colors, when chosen, allows you to change the colors of
the Shell.

DOS Utilities... is the title of a group that comes with the Shell
The ellipsis (...) indicates that this s the title of a group. How to
use the DOS Utilities group, and the utilities in that group, is dis-
cussed in Chapter 3.
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A Word About Groups.
The Main Group s the first level of the Shell’s two-level Froup st
ture. The Main Group can contain both groups and programs; sub-
groups (the second level of the group structure) can S only
programs.

For example, a word proces:
processor, a spell-checking utility, and an editor. You could title such
a group “Word Processing” and add that title to the Main Group.

Then when you select Word Processing from the Main Group (by
pressing Enter or double-clicking with the mouse), you see a sub-
group titled “Word Processing” to which you can add programs.

g group might contain a word

The following figure is an example of a group structure. Note that
when Word Processing... is selected from the Main Group, the Word
Processing... subgroup is displayed. You can then start the My Editor
program o the My Writer program from the Word Processing... sub-
group.

A program can be started (by pressing Enter or double-clicking with
the mouse) either in the Main Group or in a subgroup.

T T
\
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Adding Groups to the Main Group

You can organize your programs so that related programs are
together in a subgroup. To do this, add a group to the Main Group.
Then you can add programs right to the new subgroup, or you can
copy programs to the new subgroup from the Main Group or other
subgroups. (Refer to “Copying Programs from One Group to Another
Group” on page 87.)

Follow these steps to add a group to the Main Group.

1. Select Group from the Start ngrams action bar; then press.
Enter. You see the following screen:

o3-01-88 Start prograns 33 pm
Progran Grow  Exit | ety

o t1em, use the  and dom
o o dheply a new aro, press nter.

Comand
File Syst
Change Colors
005 Ut

Fo-hetions ShAfeoF9-Comand Prompt

Select Add... from the pull-down; then press Enter.

The other Group pull-down items are Change..., Delete..., and
Reorder.... To use any of these options, the item in the Mai
Group that you want to change, delete, or reorder must first be
selected.

The Change... item lets you modify the entries that were made
when the group was added. This includes the title, the filename,
any help text that was added, and the password. Online help is
available on all the items. The Delete... item lets you erase a
subgroup. The Reorder... item lets you place an item in a dif-
ferent location in the group contents area.
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The following is displayed:

Add Grow

Required
HOe R teie >
Filenase . . [ 1

Optional
Help text . . [ >
Password . . [ 1
EscCancel  Flshelp FosSave

‘The first two entry fields are required entries; the next two, for
help text and a password, are optional

Atthe cursor, type the group title you want to appear in the Main
Group contents area. A group title can have a maximum of 37
characters, including blank spaces.

For example, if you want this group to contain all your word proc-
essing programs, you might enter “Word Processing.”

Press Enter or the tab key to move the cursor to the next entry
field.

Type the filename for the group.
The filename can be any name you like and can have up to eight
characters. (Press F1 to see a list of the characters that cannot
be used in this entry field and to get additional information on this
entry,)

1 you do not want to add help text or a password, press F2 to
save your entries.

The group title you entered now appears in your Main Group.
When you are ready, you can select it and can add the programs.
You want in the subgroup.

The Shell adds an ellipsis (...) after group titles to help dis-
tinguish between groups and programs.

1f you want to add help text, press Enter or the tab key to move
the cursor to the Help text entry field



Enter here any help that you want to have available when
pressing the F1 key for help on this group. You can enter up to
478 characters in this field.

If you do not want to add a password, press F2 to save your
entries.

‘The group title you entered now appears in your Main Group.
When selected, the help text you entered is available by pressing
the F1 key.

If you want to add a password, press Enter or the tab key to move
the cursor to the Password entry field.

Enter a password.

A password can be up to eight characters long. You might enter
a password if you want only certain people to access this group,
or if you want to be the only one who can access this group.

Entering a password is optional. If you associate a password
with a group item, you cannot access that item without first
entering the password. If you choose 1o use a password with a
group item, be sure to record it for later reference. If you enter a
password for more than one item, it may be helpful to use the
same password for each item. Each time an attempt is made to
access this group, a prompt appears and asks for the password.
Access is denied until you enter the password.

. Press F2 to save your entries.

The group title you entered now appears on the Main Group and
when selected, shows you a subgroup by that title. You can now
add programs to this subgroup using the method described in
“Adding Programs to the Main Group.

If you want to copy programs from the Main Group to the group
you just added, use the method described in “Copying Programs
from One Group to Another Group” on page 87.

Adding Programs to the Main Group
You can add the titles of programs you have on your system to the
Main Group or a subgroup of the Shell and start them from there.
Follow these steps to add a program to the Main Group:
1. Select Program from the Start Programs action bar; then press
Enter.
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2.

Select Add... from the pull-down; then press Enter.
The other Program pull-down items are Start, Change.
and Copy.. any of these options, the program in the Main
Group that you want to start, change, delete, or copy must first be
selected

The Start item lets you run a program. It performs the same func-
tion as a double-click with the mouse ocprensing haETiagiMl
o ddalecedpuotiy The Delete... item lets you erase a
program. The Char tem lets you mndlly the entries that
ey program was added. This includes the title,
the startup commands, any help text that was added, and the
password. The Copy... item lets you copy a program from one
group to another. Online help is available on all the items.

You see the following:

Add Progran

Required

Title & >

omands . . [ >
Optional

Help text . . [ 2
Password . . [ 1

EscCancel  Fiofelp Fa=save

The first two entry fields in this pop-up are required entries; the
next two, for help text and a password, are optional

The cursor is at the Title... entry field. Type the title you want to
appear in the group to identify this program. A program title can
have a maximum of 40 characters, including blank spaces.

For example, i you have a program installed on your system
called My Editor that you want o be able to start from this group,
You can type "My Editor” for a title.

Press Enter or the tab key to move to the next entry field.

At the Commands... entry field, type the program startup com-
mands (PSCs) for this program
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The documentation that comes with an application program tells
you how to install the program and the characters to use to start
the program after you have installed it. These characters make
up the simplest program startup command (PSC). For example,
the documentation for a program called My Editor might tell you
10 type ME to start the program. ME is then the program startup
command.

There are other program startup commands to further define the
way your program works. When entering more than or
command, press the F4 key to mark the end of each command.
For information on additional program startup commands offered
in the Shell, and for detailed instructions on entering PSCs, refer
to “Program Startup Commands” starting on page 9.

1t you do not want to add help text or a password, press F2 to
save your entries.

The program title you entered now appears in your group con-
tents area and you can select it to start the program.

If you want to add help text, press Enter or the tab key to move
the cursor to the Help text entry field.

Enter any help that you want to have available when pressing the.

F1 key for help on this program. You can enter up to 478 charac-
ters in this field.

. 1f you do not want to add a password, press F2 to save your

entries.

The program title you entered now appears in your group con-
tents area. When it is selected, the help text you entered is avail-
able by pressing the F1 key.

If you want to add a password, press Enter or the tab key to move.
the cursor to the Password entry field.

Enter a password.

A password can be up to eight characters long. You might enter
a password if you want only certain people to access this
program, or if you want to be the only one who can access the
program.

Entering a password Is optional. If you associate a password

ith a program, you cannot access that program without first
entering the password. If you choose to use a password with a
program, be sure o record it for later reference. If you enter a
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password for more than one item, it may be helpful to use the
same password for each item. Each time an attempt is made to
access this program, a prompt appears and asks for the pass-
word. Access is denied until you enter the password.

11. Press F2 to save your entries.

The program title you entered now appears in the group and, when
selected, starts after the password is entered.

Adding Programs to a Subgroup
To add a program to a subgroup, you must be in that subgroup:

1. In the content area of the Main Group, move the selection cursor
to the subgroup to which you want to add a program.

Press Enter.
The subgroup you selected is displayed. (If there are no pro-
grams in a subgroup, a message appears saying “Group is
empty.”)

Follow the steps listed in “Ad
which start on page

19 Programs to the Main Group,”

Copying Programs from One Group to Another Group

If there are programs in one group that you want to have in another,
follow this method. (If you want to move a program, follow the copy
procedure listed here; then continue with the delete procedure, which
follows.)

. If the program to be copied is in a subgroup, move the selection
cursor to the subgroup title within the Main Group; then press
er.

Move the selection cursor to the program you want to copy.

Press the F10 key to move the selection cursor to Program at the
action bar; then press Enter.

4. In the Program pull-down, move the selection cursor to Copy.
then press Enter.

The selec(lan cursor is at the program that you previously
selected.

1fyou are in a subgroup, press Esc to reach the Main Group.



6. Move the selection cursor to the subgroup to which you want to
copy the program; then press Enter.
The subgroup you chose is displayed on the screen.
7. Press the F2 key to complete the copy. (You can press the F3 key
to cancel the copy.)
8. Press ESc to return to the Main Group. The selection cursor is at
the title of the subgroup you just left.
The program is now listed in the “destination” group, the group to
‘which it was copied, and in the “source" group, the group from which
it was copied. If you want to delete this program from the source
group, follow the procedure in *Deleting a Program from a Group.”

Deleting a Program from a Group
To delete a program from a group, follow these steps.

1. If the program to be deleted is in a subgroup, move the selection
cursor to the subgroup title within the Main Group; then press.
Enter.

2. Move the selection cursor to the program title that you want to
delete.

©

Press F10 to move the selection cursor to Program at the action
bar; then press Enter.

Move the selection cursor to Delete...; then press Enter.

The following panel is displayed:

Delete Item

1 Detste s ten
. Do not delete this iten

“etoter  Esc=Cancel  Fistelp

It you do not want to delete the program, select item 2; then press
nter.

To delete the program, press Enter.

I\
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Adding Predefined Subgroups to the Main Group

The Shell makes it possible for you to install subgroups that are sup-
plied by someone else. These subgroups are contained in a
filename.MEU file.

1. Copy the filename.MEU file to the directory containing the DOS
Shell. (This is usually the DOS directory.)

Select Group from the Start Programs action bar; then press

Select Add... from the Group pull-down; then press Enter.

At the Title entry field, type the title that you want to appear in the
Main Group.

Press the tab key to reach the Filename entry field.

Type the name of the supplied file (filename.MEU), leaving off the

1f you want to add help information or  password, follow the
directions listed on page 82 under “Adding Groups o the Main
Group.

7. Press F2 to save the information.

The title you entered appears on the Main Group. When you select it
from there, the subgroup is displayed with the list of selectable pro-
grams.

Program Startup Commands

When you add a program to one of your Shell groups, you are asked
for program startup commands (PSCs). The simplest program startup
command consists of the characters you enter to start the program.
These are identified in the documentation that came with the

program. When adding a program to the Shell, if you enter this
command in the Commands entry field, your program starts when it is
selected.

There are other, optional PSCs that you can use in the Commands
entry field to further define the way your program works.



Optional Program Startup Commands

The Shell offers additional options for your program startup com-
mands that you can use when you add a program to
example, you can request one or more prompts for
time the program is started.

Each prompt panel consists of a title, an instruction line, and an entry
field, and is displayed when you start the program. The default
prompt looks like this:

o018 Start prograns 3:30 .
Progran Grow  Exit | Fishelp

o select an ftem, use the arror keys to move
the selection cursor to the fte, then press Enter.

Progran Parameters
Type the parameters, then press Enter.

Paraseters . . [ >

“eenter EsceCancel Flebelp

Flomactions Shif2479-Comand Proapt

By using program startup commands offered in the Shell, the title,
instruction line, and entry field prompt lines can have information that
is specific to your needs. (The information entered in response to the.
prompt is passed as a parameter to the program you are starting.) In
addition, you can tailor the activities of the program in other ways.

Following is a list of PSC options that the Shell offers. The options
shown in brackets control the information in the prompt panel. These
must be entered between the brackets. Options shown between
brackets can be combined inside one set of brackets. The options
‘shown without brackets must be entered outside the brackets.

8] To perform the default prompt each time the program is
started.

[T“."]  To define a title for the prompt panel. The maximum
length for the title is 40 characters.
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/e %n"]

To define an instruction for the prompt panel. The
maximum length for the instruction is 40 characters.

To define a prompt for the entry field in the prompt panel.
‘The maximum length for the prompt is 20 characters.

To save what you have entered (the value) in the Parame-
ters... area (entry field) for future use. The “n” can be
any number from 1 through 10. When used, %n must be
the first character or characters inside the brackets.

To use the value entered at run time. For example, if the
value is a file that has been edited, print %1 causes the
identified file to print each time this program is started.
When used, this option must be entered outside the
brackets.

To have a default value appear in the entry field each time
a program’s prompt is displayed. You can change this
default value at run time by typing over it and clearing any
remaining characters. This entry can be up to 40 charac-
ters long.

To have a default value appear in the entry field each time
a program’s prompt is displayed. This default is a previ-
ously entered value saved with the [%n] option. You can
change this default value at run time by typing over it and
clearing any remaining characters. This entry can be up
t0 40 characters long.

To clear the default value in the entry field when the first
key pressed s any key other than an edit key.

To set the maximum length of the entry field to fewer than
127 characters. The maximum length is 127 characters. If
the length is not specified or is invalid, the maximum
length is used.

To allow the use of only existing filenames. The existence
of the value entered will be verified before the PSC is exe-
cuted,

To save the %n value entered in the preceding task as the
value for this parameter for the current task; otherwise,
%n has no value.



[F“."]  To check for the existence of the file specified. This entry
can be up to 76 characters long and can be used more
than once. For example, /F“d:\path\filename.” This check
takes place after the Enter key has been pressed on the
prompt panel and is used to ensure that the proper
diskette s in the drive before the Shell is suspended to
execute the program startup commands. f the file exists,
the PSC continues. f the file does not exist, a beey
sounds and the panel is redisplayed. TM: e has
no effect on the format of the prompt and din
the program startup commands which are R

3 To substitute the drive letter (which designates the drive
from which the Shell was started) and a colon into the
PSC. These characters must be entered outside the
brackets.

e To substitute the path from the ROOT from which the Shell
was started, including the current directory, into the PSC.
The path is not preceded by a back slash. These charac-
ters must be entered outside the brackets.

Any batch file command, with the exception of GOTO state-
ments, can be used as a program startup command. (When
using the FOR command, the “n” in %n must be alphabetic.)
Any characters in the PSC, other than the optional commands,
are passed to the DOS batch file processor exactly as written.
A direct substitution is made by the Shell for any PSC option
used outside of the brackets. The information entered in
response to the prompt is substituted for each set of brackets
and its enclosed options.

Press F4 at the end of each command when entering more than one.
program startup command in the Command:

Batch Fil
To start a batch file using a PSC, the batch file name must be pre-
ceded by CALL. If the batch filename is not preceded by CALL, the
program will not return properly on completion. For example, to start
a batch file named BATCH.BAT, you would enter the following PSC at
the Commands entry field.

Comands . [CALL BATOHBAT B

L}
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If you want to use some of the options offered for program startup
commands, you must include the contents of the batch file in the PSC,
Use the bracketed options to prompt for any required parameters.

PAUSE and ECHO Commands
Itis useful to insert a PAUSE command at the end of each PSC list so
that, before returning to the Shell from your program, you can view
any DOS messages that may appear.

If you add an ECHO command with a message statement to your PSC
list, that message appears on your screen. The ECHO message can
be whatever remark is correct for the program you are starting.

Inthe tonewmg example, the remark “Insert diskette with ME in drive
Ais

nds. . . [ECHO Tnsert diskette with ME in >
drive A||PAuse| [ue

Note that the || is the symbol that appears when you press F4 to sepa-

rate commands. By entering the ECHO command with this remark,

the following is displayed when the My Editor program is selected:
skette with ME in drive A

s any key to continue

At the ECHO command, you have the opportunity to insert the needed
diskette; at the PAUSE command, the system pauses to display any
DOS messages, and the system again displays the message “Press
any key to continue...” before returning to the Shell. (Note that, in
this example, the PSC | n on two lines. This is done here to
show it in its entirety. On the screen, this is  scrollable field, and the
commands are entered in a continuous string.)

Using Additional Program Startup Commands
1f you add a program (for example My Editor) to one of your groups,
You can enter the following in the Command entry field:

ile to be



Following is a definition of the program startup commands in this.
example:

ME Is the PSC for the program.
[T Edit File” Defines the title you have chosen for the
prompt.

/1“Enter file to be edited by ME.”
I the instruction line.

IP“Filename . . " Defines the prompt for the value field.

ez Says that 12 characters is the maximum
number of characters that can be entered
in the value field.

1 Is the symbol that appears when you sep-
arate commands by pressing the F4 key.

By entering these program startup commands for the My Editor
program, when you choose My Editor from the group, you see the fol-
lowing prompt:

Edit File
Enter file to be edited with ME.

Filename . . [ ]

deenter Esc-cancel Flotelp

. Type the name of the file you want to edit in the entry field. This
can be the filename of an existing file or a file you want to create.
For example, if you enter MYFILE.DOG at the prompt, the ME
editor is started using that filename as a parameter.

2. Press Enter.

Any DOS command, except a GOTO command, can be entered as a

PSC. For example, to add a PRINT command to the command list

shown previously, the commands are entered as follows:

ited by M
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The %1 causes the parameter entered i response to the prompt
panel to be passed to the PRINT program also. The PSC list entered
iin this way still gives you the prompt when the program is selected,
and it sends the document to print before returning to the Shell

Exploring Details in the File System

In Chapter 3, the File System portion of the Shell was explored. Fol-
lowing is a more detailed description of the File System.

Note that the files shown on your screen may be different from those
used in these examples.

Action Bar

3-01-88 File systen 3:30 o
File Options Arrange Exit | Fiotelp

ABC

cons

Directory Tree More: + f
&
> Coos

030188
Conan Scor ey asotam

FlomActions  ShiftsFo~Comand Prompt.

The action bar in the File System has four activity items and
=Help. The items offer the following activities:

* File lets you start a program; print, move, copy, delete, or rename
afile; change a file’s attributes; view a file in ASCII (readable
text) or hexadecimal (base 16 numbering system used by pro-
grammers); or associate a file with a program. In addition you
can create, rename, and delete directories and subdirectories,
select all the files listed in the file list at one time, and deselect
all the files at one time.

he Rename... and Delete... options apply o both files and direc-
tories. If no files are selected, a directory operation is assumed.

9



The Open (start)... item lets you start the executable (aunama)

file list and press Enter, and (2) place the mouse pointer over the
startable file and double-click

The Assoclate... item lets you associate a file extension with a
program on your system. When a f
program, the Shell starts the program each time you select a file
with that extension. For example, the program My Editor (ME)
could be associated with the .RUN extension. Then, if you want to
edit a file with a .RUN extension (for example, MEMO.RUN), the
ME program starts when you press Enter on the selected file or
double-click with the mouse on the filename.

An example of copying a file is given on page 101. The other
options available when you choose File work similarly. Online
help is also available on any option you highlight.

Options lets you sort files by name, extension, date, size, or disk
order; enter the name of a specific file to list in the file list;
display the file status of the last highlighted file; change the Shell
50 that you can select files across directories; and make choices
whether or not to receive a confirmation panel for the copy and
delete activities.

Arrange lets you choose from three display choices. The display
shown here is the Single file list choice. Other choices are Mul-
tiple file list, which displays the files in two directories or two
drives of your choosing at the same time, and System file list,
which displays all the files across the drive plus the file status
panel.

Exit lets you exit File System to Start Programs or resume File
System.

13
E
E
E
E
E
E
E
3
3
E
3
E
| 3



Drive Identifier Area

P [— 5530
File Gptions arrarseBxt | Ficiy
hec
cioos
Directory Tree Hores 1 e e s
ws s s ool
- Cos W0 BE 0 ool
o G w0l
e oo
ar o018
wsic om s
wsion oo
ook oo
om0 i e 011

FloActions  ShiftsFo-Comand Prompt

This example shows three drives: A, B, and C. The current drive, C,
is highlighted.

To change the drive, tab to the Drive Identifier area and use the arrow
key to move the selection cursor to a different drive; then press Enter.



Path Are:
o3-01-88 File Systen -
File Options Arrange  Exit | Fiokelp
a8 c
cioos
Directory Tree More: t Wore: 4
NSL st 9% 030188
00 D€ 110 030188
ASsIGn o 5805 030188
ATTRIS L 18,251 03018
PN 33,68 630188
wSic oM 1,085 030188
wSicA lcon 36,285 030188
CHOSK LM 17,599 030188
oM [N 37,653 030188

Fl0-ictions  ShiftsF9-Comand Proapt

The path area on the File System shows the path of your current, or
active, drive and directory. In the example above, the path (C:\DOS)
shows G as the current drive and DOS as the current directory. If you
have a multiple screen display, the path reflects the path of the drive
and directory that is active (the one in which you are working)
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Directory Tree

File systen

3-01-88 3:30
File Options Arrange  Exit | Fissetp

Directory Tree More:

Flomhctions  ShiftsF9-Comand Prospt

This example shows the directory structure in drive C. It shows one
subdirectory named DOS. The 5ymbol in front of the DOS directory
indicates DOS is the current direct




File List
o3-01-88 File systen 30 pm
File Options Arrange _Exit |
Asc
chons
Directory Tree More: * o

15
MPED BE 110 030188
T 5
ATRIB DE 1825 30188
BOOP LM 33,608 03018
mSIc oW 1085 03088
oo
CHOSK LN 17,599 03-01-88
om0 Cn 37,653 030188

FO-ictions  Shiftsf9-Comand Prompt

The files in the current directory (in this case the DOS directory) are
shown in the file list area. All the files in the current directory are
shown when *.* is used in the filename field of the Display options...
pop-up. The Display options... pop-up is reached by selecting
Options at the action bar.

You can start a program in the file list by selecting the file and
pressing Enter. With a mouse, place the mouse pointer over the
name of the startable file and double-click to start the program.

Note: Starting programs that end but stay resident in memory (Termi-
nate and Stay Resident or TSR programs such as networks,
PC-to-host communications, and other programs that run in a
different session but remain in memory) from the Shell
command prompt results in an inefficient use of memory. A
TSR program can be used efficiently by starting it either from a
group in "Start Programs"” or by starting the TSR program
before starting the Shell. (Refer to the documentation that
came with the program for the program startup command.)
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Copying a File

This description of copying a fle is provided as an example of the
many tasks you can do by selecting File at the File System action bar.
The other items in the File pull-down work similarly. When selecting
any item, you can press F1 for online help. (For more detailed
instructions for copying a fle, refer to page 66.)

Select File System from the Main Group; then press Enter.
2. Deselect all previously selected files.

3. Select the file (o files) you want to copy.

4. Check the Show Information panel.

a. Press F10 10 reach the action bar and select Options; then
press Enter.

b. To see the file status, select Show Information... from the
pull-down; then press Enter. (The Show Information panel
shows how many files are selected across the drive. In this
way, you can make certain that the only files selected are
those you want to copy. A complete explanation of this panel
is on page 62)

c. Press Esc to exit the Show Information panel.

. Select File at the action bar; then press Enter. You see the
following:

o3-01-88 File Systen 3:30
File Options Arrange  Exit | Fietelp

open (start)
“rint...

Assaciate.

Hor
Co
Delete.
Renane.
Change aitribute....
View

> o125 .78

1005 con
oM oM
CONFIG_SYS
AUTORXEC. BAT

Create girectory....
.

Deselect a11

FlO-Actions  ShiftsFa-Comand Prompt
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Note that some of the items in the pull-down are followed by an
ellipsis (...). In the Shell, when you see an ellipsis, it means that
a pop-up follows when you select that item. An asterisk (*) within
an item means the item is not selectable. (In graphics mode, the
unselectable item is shaded or “blurred.”

Select Copy... from the pull-down; then press Enter.

You see the following on your screen:

Copy File
Fron:  [012345.678 -
T

e\ >

ebnter  Escelancel  Flebelp

The From: field shows the files which will be copied, to a

maximum of 256 characters.

Type in the name of the destination directory, including the drive

and path. Also, if you want to change the name of the file, you

can do that here. For example:

Ci\direct1\ i)
(Enter the nane o t e in

You see the following on your screen:

Copy File
Copying file: 0I12M5.678  lof 1
Filenane already exists. Select an option.

. Skip this file and continue
2. Replace this file

efnter  Escetancel  Flekelp

It a file by the same name as the one you selected exists in the
n directory, you see this confirmation panel and can
choose to continue the copy activity or cancel it.
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The fi

To skip this file and not copy it, press Enter. If you want to write
over the file that exists in the destination directory, go to step 7.

. Select option 2; then press Enter.

you selected is now in the destination directory (the directory.

you copied the file to) and in its original directory.

Deleting a File

This description of deleting a file is provided as an example of the
many tasks you can do by selecting File at the File System action bar.
‘The other items in the File pull-down work similarly. When selecting
any item, you can press F1 for online help. (For more detailed
instructions for deleting a file, refer to page 69.)

o o

Select File System from the Main Group; then press Enter.

Deselect all previously selected files.

When deleting a file, it is especially important that you deselect
any files you may previously have selected.

Select the file (or files) that you want to delete.

Check the Show Information panel, using the procedure you
learned previously.

When deleting a file, always check the file information to veri
how many files are selected. Because the Show Information
panel shows how many files are selected across the drive, you
can make sure that only the files you want to delete are selected.

. Select File at the action bar; then press Enter.

Select Delet

rom the File pull-down; then press Enter.

A panel is displayed showing the name of the file or files you
selected to delete,



7. Press Enter. The Delete File confirmation panel is displayed:

Delete File
Deleting file: 012M5.6%8  1of 1
Select an opt

fon.
L. SKip this file and continue
2. Delete this file

+legnter  EsceCancel FleHelp

The name of the first file you chose to delete is named (in this
example, 012345.678) in this panel. The "1 of 1" means that only
one file is selected for deletion. If there were, for example, three
files selected, this would show 1 of 3." Option 1 is highlighted.
If you decide not to delete the file, press Enter to skip the file
delete. If you decide to delete the file, continue the delete
process.

8. Move the selection cursor to option 2; then press Enter to delete
the file.

If you selected more than one file to delete, the confirmation
panel again is displayed and you can choose whether to delete.
the next file. If the file named is a file you want to delete, con-
tinue the delete process as shown in the previous step.

The file is deleted and no longer is listed in the file list.

Eliminating Confirmation Panels

Each time you delete, copy, or move  file in the Shell, a confirmation
panel is displayed so that you can verify the activity. By selecting
Options at the action bar, you can deactivate this panel. When you
restart the Shell, these panels are again activated.

Eliminating Delete Confirmation Panel

Select File System from the Main Group; then press Enter.

2. Move the selection cursor to Options at the File System action
bar; then press Enter.

The Options pull-down lists three items, and the selection cursor

is on Display options.... This option is discussed in the tour in
Chapter 3.




3. Move the selection cursor to File options...; then press Enter.
The following pop-up is displayed:
File Options
> Confirm on delete

> Confira on replace
Select across directores

lenter Esc=Cancel Fi-telp

Note that the selection symbol is displayed in front of Confirm on
delete and Confirm on repla

4. Press the spacebar to remove the selection symbol on Confirm

on delete.

5. Press Enter. This saves your entries and returns the selection
cursor to the action bar.

Warning: With the selection symbol removed, this item is deselected
and the confirmation panel for the delete function is no longer dis-
played

Eliminating Move and Copy Confirmation Panels

1. Move the selection cursor o Options at the File System action
bar; then press Enter.

Select File options... from the pull-down; then press Enter.

Move the selection cursor to Confirm on replace.

Press the spacebar to remove the selection symbol on Confirm
on replace.

o

Press Enter. This saves your entries and returns the selection
cursor to the action bar.

Warning: With the selection symbol removed, this item is deselected
and the confirmation panels for replacing files using the move and
copy functions are no longer displayed.



Selecting Files Across Directories

In the Shell, when you select a file, then change directories, the
selected file is deselected. By following these steps, you will be able
1o select files in more than one directory at the same time. When you
restart the Shell, this option s deactivated. (Selection across directo-
ries is always allowed if the System file list is displayed.)

1. Select File System from the Main Group; then press Ent

2. Move the selection cursor to Options at the File System action
bar; then press Enter.

3. Select File options... from the pull-down; then press Enter.
4. Move i to directori
Note that there is no selection symbol displayed in front of Select e
across directories. Because this item is not selected, you cannot
select files in more than one directory at a time. 15
5. Press the spacebar to be able to select files across directories. I
6. Press Enter. This saves your entries and returns the selection
cursor to the action bar. 13
IE ‘
13
13
=
&
13
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Shell Special Key Assignments

‘Some keys perform special tasks in the DOS Shell. Figure 4 lists.
these assignments. (When a panel is displayed over the File System
or Start Programs, not all these key assignments are active.)

Task Key

Cancel Esc

Enter ]

Move the cursor Tor | or—or
‘Switch panel area in File System Tab

Single file select and deselect Spacebar
Scroll information PgUp or PgDn
Help Fl

In Start Programs, save information and com-  F2

plete copy

Exit the Shell from Start Programs F3

Exit the Shell from File System if thereisno ~ F3

Start Programs

Return to Start Programs from File System  F3

Cancel copy in Start Programs F3

Create separator mark in PSC list F4

View files in ASCII or Hex Fg

Keys when in Help F9.

Switch to and from action bar F10

Index when in Help. F11 (AIt+F1)
Switch to Shell command prompt Shift+F9

Figure 4. Shell Key Assignments
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Chapter 5. Additional Installation
Information

This chapter provides information on special installation and config-
uration procedures for DOS 4.00 and the DOS Shell.

Installing Keyboard Password

If you have a Personal System/2 with a partition greater than 32MB
and you want to install a keyboard password using the Quick Refer-
ence and Reference Diskette package that came with your system,
use the following procedure:

Start your system.

Insert the Reference Diskette in drive A.

Press the F3 key at the Shell screen to reach the DOS prompt.
Type A: at the DOS prompt; then press Enter. This changes the
default drive from drive C to drive A. For example:

original DS
new drive de

rompt

gnation)

(new prompt)
5. Atthe new prompt, type COMMAND; then press Enter.

The first screen of the Reference Diskette is shown on your monitor.
To install a keyboard password, follow the instructions in your Quick
Reference manual.

The prompt for a keyboard password on a PS/2 normally occurs after
the system reads the AUTOEXEC.BAT file. It is necessary to prompt
for the keyboard password, however, before the system starts the
Shell. To get the prompt for the keyboard password before the Shell
starts, insert a PAUSE statement in the AUTOEXEC.BAT file just pre-
ceding the DOSSHELL entry. (DOSSHELL is the last entry.) You are
then prompted for your keyboard password before the Shell starts.




Installing Additional Devices

It you acquire additional devices (printers, a mouse, and so on) that
you want to install after you have installed DOS 4.00 using SELECT,
refer to the DEVICE command in Using DOS 4.00.

Customizing the DOS Shell with Startup Options

During the SELECT program, you see a screen in which you can

review or change mmunlnn choices. One of these review screens,
titled DOS Shell Par hows you the startup options that
SELECT installs withthe DOS Shell. At this screen, you can choose
the startup options (parameters) to configure the Shell.

Figure 5 shows a list of the startup options that SELECT installs if
your system has at least 360KB of memory. You can change or elimi-
nate any o these options. (These are the options listed in the DOS
Shell Parameters screen.)

Note: On some systems, although color is available, the Shell is
installed with startup option /C02 (without color) by default to
achieve better resolution. You can change to color by adding
one of the following startup options: /TEXT, /01, or /C03.
Refer to the section "Additional Startup Options” for an expla-
nation of these startup options and instructions for adding
them.

Startup Option M

/MOS:PCIBMDRV.MOS ~ Identifies the mouse driver. This option
identifies the IBM PS/2 mouse driver.

ning

IMENU Activates Start Programs in the Shell.

/D0S Activates File System in the Shell.

/PROMPT Allows access to the Shell command
prompt.

Figure 5 (Part 1 of 2). Installed Startup Options in the DOS Shell
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Startup Option Meaning

JEXIT Activates the Exit Shell option.

IMAINT Activates the ablllly to do maintenance
in Start Progras

/COLOR Activates the Change Colors option.

ITRAN Allows operation of the DOS Shell in

transient mode (except the base driver).

/MEU:SHELL.MEU

Identifies the filename of the Main
Group structure for Start Programs.
This option allows network environ-
ments to concurrently identify unique
menu structures for each node while
locating a single copy of the DOS Shell
on the server.

ICLR:SHELL.CLR

dentifies the filename m |ha colnr lalup
le use. SHELL.GLF

MUL

Provides multiple File System directory
and file butfer.

ISND.

Activates sound while running the Shell.

ISWAP

Activates saving (swapping) File System
directory and file information to a disk
file while performing tasks at the Shell
command prompt or activating a
program. (If the computer is turned off
without exiting the Shell, or if there is a
power failure, a temporary file s left on
the disk. These files need to be deleted
on occasion so as not to clutter up the
fixed disk.) The /SWAP option increases
Shell performance and is most effective
on afixed disk system.

/DATE

Displays the date and time.

Figure 5 (Part2 of 2). Installed Startup Options in the DOS Shell

By selecting startup options, you can tailor the DOS Shell to fit your
needs and the size of your system. Listed here are three suggested

m



(For all these
maximum DOS 4.00 configuration size of 60KB without the Sheiis
assumed.)

Suggested Startup Options with at Least 256KB of
Memory

For Start Programs.

/PROMPT Activates the Shell command prompt.

/MENU Activates Start Programs in the Shell.

IMAINT Activates the Program and Group options.

TRAN Operates Shell in transient mode.

/MOS:PCIBMDRV.MOS ~ Identifies the mouse driver.

/COLOR Activates the Change Colors option.

JEXIT Activates the Exit Shell option.

Display mode See "Text or Graphics Mode.”

For File System

/PROMPT Activates the Shell command prompt.

ISWAP. Activates saving directory and file informa-
tion (assumes fixed disk).

TRAN Operates Shell in transient mode.

™ MOS Identifies the

EXIT Activates the Exit Shell option.

/D08 Activates File System.

Display mode See “Text or Graphics Mode.”

Suggested Shell Startup Options with at Least 360KB of
Memory

It you have a system with at least 360KB of memory, the Shell can be
installed using all the startup options listed in the DOS Shell Parame-
ters screen.

Ix
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Text or Graphics Mode

The DOS Shell can be displayed in ither text or graphics mode. The
startup options are /TEXT, /CO1, /C02, and /G03. I none of these
options is specified, SELECT uses the highest available video mode
that your system can support.

Note: Some Terminate and Stay Resident (TSR) programs (such as
networks, PC-to-host communications, 3270 emulators, and
other programs that run in a different session but remain in
memory) can be accessed successtully from the Shell only
when the Shell is operating in text mode. For instructions on
how to add the text mode parameter (/TEXT), refer to the
section “Changing Startup Options,” which follows.

I you want to operate the Shell in graphics mode, you can
switch to a TSR program that operates in text mode by
pressing Shift-+F9 the Shell. This brings you to the Shell
command prompt. At the Shell command prompt, which oper-
ates in text mode, you can press the key combination that is
defined by the application and continue using the TSR
program.

Resident or Transient Mode

Installing the DOS Shell in resident mode means that, each time you
start the Shell, It resides in temporary memory on your system (as
opposed to the permanent memory of the Shell diskette or your fixed
disk). If you install DOS 4.00 to diskette, choosing resident mode for
the Shell makes it possible to start the DOS Shell and remove the
Shell diskette from your computer. The Shell remains resident in
temporary memory for you to use. You can then insert a different
diskette and still use the Shell.

Installing the DOS Shell in transient mode means that when you start
up the Shell, it does not remain in temporary memory on

system. If you install DOS 4.0 to fixed disk, choosing transient mode
for the Shell allows you to use the Shell (because it can be accessed

from your fixed disk) and frees temporary memory for other use.

SELECT installs the DOS Shell in transient mode. If you want to run
the Shell in resident mode, remove the transient mode startup
command (/TRAN) from the DOSSHELL.BAT file.



Additional Startup Options
There are additional startup options available for the DOS Shell that
can be added either during or after installation. You can change,

add, or delete the startup option

the Shell at any time. Figure 6

shows these additional options:

Startup Option

IF

Sets the mouse for left-hand use.

TEXT

Displays the Shell in text mode.

1cot

Displays the Shell in 16-color, high-
resolution 640 x 350 graphics (mode 10).
(This option is possible only if the
appropriate hardware is available.)

1c02

Displays the Shell in two-color,

high-resolution 640 x 480 graphics
(mode 11). (This option is possible only
if the appropriate hardware is avail-
able)

1003

Displays the Shell in 16-color, high-
resolution 640 x 480 graphics (mode 12).
(This option Is possible only if the
appropriate hardware is available.)

MOS: .MOS

Activates the mouse
driver, part number 039-099.

/MOS:PCMSPDRV.MOS

Activates the Microsoft parallel mouse
driver, part number 037-099.

B:nKB

Specifies the amount of memory in KB
to be used for the File System file
buffer. For example, an entry of /B:3KB
specifies a 3KB buffer. With this option,
you can restrict the Shells use of
memory. This is particularly significant
when operating the Shell in resident
mode.

Figure 6 (Part 1 of 2). Additional Startup Options Available in the DOS
Shell
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Startup Option

Jcom2 Allows serial mouse to be used on the.
second serial port (installation default is
COM1),

Figure 6 (Part2 of 2). Additional Startup Options Avallable in the DOS'
Shell

Mouse Driver Alternatives
The Shell comes with the three mouse drivers described in Figures 5
and 6. A different mouse can be used with these drivers for the Shell
it its interface specifications match those of one of the three mice
supported. If you use a mouse outside the Shell, a device driver must
be provided for that mouse and identified with a DEVICE = statement
in the GONFIG.SYS file.

The Shell also supports any mouse i its interface specifications
match Microsoft’s specifications. (To use this method requires 5KB
t0 12KB, whereas the three drivers described in the tables require
1KB.)

1. Install the mouse driver that came with the mouse. Use the

instructions that you received with the mouse.

2. Remove all /MOS startup options from the DOSSHELL.BAT file.

3. Start DOS 4.00.
Some Terminate and Stay Resident (TSR) programs do not recognize
mouse support. If you use a mouse with the Shell and access a TSR
program, you may see a shadow of the mouse pointer in the TSR

program. This does not affect the way your TSR program works and
can be ignored.

Changing Startup Options
To view the DOS Shell startup options presently on your system, from
either Start Programs or the File System, do the following:

1. Press F3 to reach the command prompt.
2. Atthe prompt, type:



3. Press Enter. Your DOSSHELL.BAT file will Iook similar to this

example:

CD C:\00S

PRINT

@PROMPT When ready to return to the DOS Shell, type EXIT, then
press enter.$_$pg

SHELLB DOSSHELL

IF ERRORLEVEL 255 GOTO END

COmon

@SHELLC /MOS: PCIBHDRY .M
TRAN/MEU: SHELL . MEU/CL
END

@BREAK=ON

@PROMPT $PSG

S/MENU/DOS /PROMPT /EXIT/MAINT/COLOR
SHELL. CLR/MUL/SND/SWAP/DATE

The entries after “SHELLC" indicate the installed startup options.
You can delete any of them or add to the list. You do this by using a
text editor such as EDLIN, the text editor that comes with DOS 4.00.
Instructions on using EDLIN are in Appendix A of Using DOS 4.00.

For example, if you want to set your computer for use with a left-hand
mouse, you can add /LF to the list of options. You can add /LF any-
where in the string; it is shown here added at the beginnin,

OSHELLC. /LF/MOS: PCIBNDRV  MOS/MENU/DOS /PRONP
RAN/MEU: SHELL . MEU/CL

IT/MAINT/COLOR
SHELL.CLR/MUL/SND/SWAP/DATE
When you complete any changes or additions that you want to make,

save the file and restart the Shell by typing DOSSHELL at the
command prompt and pressing Enter.

Note: If conflicting options are present, an invalid option is entered,
or an option is misspelled, an error message is displayed.

=
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Using the DOS Shell in a Network

There are two ways you can use the DOS Shell in a network. You can
install it to use a single set of files which are shared by all the nodes,
or you can install it to use a different set of unique files for each node.

For the instructions and examples that follow, it is assumed that the
Shell is being installed on a server machine and that it will be shared
by a number of nodes.

Warning: The contents of some of the Shell files (those with .MEU,
GLR, and .ASG extensions) can be changed during a Shell session,

thereby interfering with work being done by someone on another
\ode. The two install procedures that follow eliminate this exposure.

Sharing One Set of Files
To use a single set of DOS Shell files to be shared by all nodes, do
the following:

1. Install DOS 4.00 on the server.

2. If you want to make changes to the Shell (such as adding pro-
grams, changing colors, or adding an associate file), start the
Shell and make the desired changes.

3. Change the attributes of SHELL MEU, SHELL.CLR, and any other
.MEU, .CLR, and .ASC files to read-only. (The .ASG files are
created only after the associate function has been carried out.)

4. For each node, provide a Shell batch file that does not contain the
/MAINT and /COLOR startup options.

These batch files must also reside on the Shell server.

When creating a new Shell batch file, the name of the batch file must

appear on the same line with SHELLB.COM. In the following exam-

ples, this is shown as SHELLB SHELLN1, SHELLB SHELLN2, SHELLB

N1, and SHELLB N2

Explanations of the Shell startup options (/TRAN, /TEXT, /MAINT and
0 on) begin on page 110 of this chapter.



If the Shell is installed on the server machine in the SHELL directory
and the nodes are using it by accessing drive E, a batch file for node
N1 might 100k llke this:

SHELLN1.BAT

IF ERRORLEVEL 255 GOTO EJ
COMMON
HELLC /TRAN/TEXT/DOS/MENU/EXIT/MEU: SHELL. MEU

A batehfile for node N2 might ook like this:
SHELLN2.BA

€D \SHELL

SHELLB SHELLN

F ERRORLEVEL 255 GOTO END

OMON

/D0S /MUL/PROMPT /EXIT/MEU: SHELL .MEY

Using a Unique Set of Files for Each Node
To use a separate set of files for each node, o the following:

1. Install DOS 4.00 on the server.

2. For each node, make copies on the server of all the .MEU, .CLR,
snd .ASG files, assigning names to them that are unique to each
fe.

For example, the files for node N1 could be named N1.MEU,
N1.CLR, and N1.ASC. The files for node N2 could be named
N2.MEU, N2.CLR, and N2.ASC, and 50 on.

3. For each node, provide a Shell batch file that contains the .CLR,
MEU, and .ASC filenames that you have assigned to it.
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For example, if DOS 4.00 is installed on the server machine in the
SHELL directory and the nodes are using it by accessing drive E, a
batch file for node N1 might look like this:

N1.BAT

£

€D \SHELL

SHELLB N1

IF ERRORLEVEL 255 GOTO END

+COMHON

/MAINT/COLOR/TRAN/DOS /EXTT/SHAP/MEU:N1 .MEU

A bateh file for node N2 might ook like this:
N2.BAT

E:

€D \SHELL

SHELLB N2

IF ERRORLEVEL 255 GOTO END

+COMMON
SHELLC. /MAINT/COLOR/DOS/MUL/PROMPT /EXIT/MEU:N2 . MEU
1END

Receiving Messages

f the Shell is installed on your system in text mode, any messages
that you receive are displayed directly on your screen. You can
refresh the screen by reselecting the displayed option. To avoid this
inconvenience, save your messages in a file or direct them to a
printer.

If the Shell is installed in graphics mode, messages are not dis-
played. You must therefore log your messages.

Refer to your network manual for instructions on saving your mes-
sages in alog.
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Chapter 6. Partitioning Your Fixed Disk

During installation, if you are installing to a system that does not have
a partitioned fixed disk, you can either let SELECT partition your fixed
disk for you or make the partitioning decisions yoursel. If you
choose to make your own decisions about partitioning your fixed disk,
you see a screen titled FDISK Options. How to make these decisions
is explained in this chapter.

About Your Fixed Disk

‘The fixed disk can be logically divided into as many as four partitions.
One reason to divide your fixed disk is to be able to share it among
operating systems. A partition defines the area of the fixed disk that
belongs to a particular operating system. In this way, you can have
more than one operating system on a fixed disk at the same time,
each residing jon. However, only one operating
system can be used at a time. To create partitions for an operating
system other than DOS 4.00, refer to the installation procedure for
that operating system.

DOS has two partition types. The first partition, and the only one that
is required to use DOS on a fixed disk, s called a primary DOS parti-
tion. This partition must exist to start DOS from the fixed It can
be any size up to the size of your entire fixed disk (100%).

The other type of partition used by DOS is called an extended DOS
partition. This partition also can be any size within your fixed disk
space limitations, and it can be subdivided into multiple areas called
logical drives. A logical drive can be any size you choose within the.
size limitations of the extended partition. When you start DOS, each
logical oin assigned a drive letter that you can use to access that
drive, just as if it were a separate fixed disk. For example, if you
have one fixed disk and you create a primary DOS partition, an
extended DOS partition, and one logical drive in the extended DOS
partition, DOS assigns the drive letter C to the area of the disk
defined as the primary DOS partition and D to the area defined as the
logical drive. You can create logical drives up through drive letter Z.




FDISK allows you to create both a primary DOS partition and an
extended DOS partition on each fixed disk. It also allows you to
divide the extended DOS partition into logical drives.

Adding a Fixed Disk

When you add a second fixed disk to your system, FDISK assigns the
drive letter D to the primary partition of the second fixed disk. If your
first fixed disk has an extended partition containing logical drives, the
logical drive letters change.

FDISK assigns drive letters sequentially to the primary partition of
each fixed disk before assigning drive letters to the logical drives. It
also assigns drive letters to all the logical drives on the first fixed
disk before assigning drive letters to the logical drives on the second
fixed disk.

This results in your logical drive letters being reassigned if you run
FDISK on a second fixed disk after logical drive letters have been
assigned on your first fixed disk.
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Using FDISK

FDISK displays menus that guide you through the tasks. This is the
menu you see if you choose to make your own decisions in parti-
tioning your fixed disk:

25 Vrsion 4.0
Setup Progran
oot 1ot cope 195 1588
FOISK Options
Current fixed disk drive: 1
Choase one of the folloving:
Create 005 Partition or Logical 005 Orive
tition or Logical 005 Drive

Display partition Information
L Select next fixed disk drive

£
H
2

enter choice: [1]

Press Esc 1o exit FDISC

Item 5 appears only if you have more than one fixed disk.

Select your option from this menu. After making a selection, you see
additional menus.

Some menus display a default value in the Enter cholce area. (On
this menu, it's a1.) If you want the default value as your choice,
press Enter. If you want a value other than the default, type the value
Yyou want; then press Enter.

Warning: A warning message appears if at least one de
exists, but the partition is not marked active. This warning indicates
that the disk will not start up (boot). If you get this warning and you
want to start from your fixed disk, select option 2. Set active partition.




Creating a DOS Partition or Logical DOS Drive

(Option 1)

It you choose option 1. Create DOS Partition or Logical DOS Drive

from the FDISK Options menu, you see the following:

Create 005 Partition or Logical 005 Drive

Current fixed disk drive: 1
Choose one of the folloving:
1. Create Prinary D05 Partition

Create Extended 005 Partition
3. Create Logical 005 Drive(s) in the Extended 005 Partition

enter chofce: [1]

Press Esc to return to FDISK Options

If you want to create a primary DOS partition, press Ent
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Creating a Primary DOS Partition
If you choose option 1 on the Create DOS Partition o Logical DOS
Drive menu, the following s displayed:

Create rinary 005 Partition

Current fixed disk drive: 1

Do you wish o use the maxisum available size for a Primary 00S Partition
and nake the partition active (1/N) 2m

Press Esc to retur to FOISK Options

Do one of the following:

« Press Enter (Y is the default) if you want to use the largest avail-
able space for your primary DOS partition and you want DOS to
start from the fixed disk. Your DOS partition is made active. If
you have more than one fixed disk, the FDISK Options menu is
displayed again.
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If you are done partitioning your fixed disk, you see the following:

You must restart. your computer to continue.

Press CerlvAltaDe] to continue with DOS fnstallation.

This message is dlsplayad any time you finish using FDISK while
installing using SELE(

Follow the instructions on the screen by pressing Ctrl +Alt+Del
to restart your system. Screens follow to inform you mn lhe lesd
disk is formatting and when you must insert the req

« Type N (no) if you want to use part of the fixed disk for an
extended DOS partition or another operating system. (Refer to
“Using Part of a Fixed Disk for DOS.")
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Using Part of a Fixed Disk for DOS
1f you want to use only part of the fixed disk for DOS, type N (no); then
press Enter. The following screen is an example of what you see:

Create Prinary 008 artition

Current fixed disk drive: 1

Voo e
Table for partition 15 120 Mytes (106%)

e paditon stze 0 teytes r prcen o disk soce (4)
create a Prisary D05 Partition,

Mo partitions defined

Press Esc to return to FDISK Options

“Total disk space” indicates how many megabytes (MB) are on your
entire fixed disk. The “Maximum space available for partition” value
is the maximum amount of contiguous space that is available on your
fixed disk. (There may be space In several locations on your fixed
disk. Contiguous space s space in an unbroken sequence.)



If you want your DOS partition to be as large as possible, press Enter.

The default value is the maximum space available. If you want to
suicka e s the value you want in either megabytes or
percent; then press Enter. To enter in percent, use the numerals plus.
the p.mm symbol (for example, 25%). To enter in megabytes, use
only the numerals (for example, 30).

Note: To allow you to enter partition and logical drive sizes in per-
centages that reflect less than 1 necessary for FDISK
1o round upward the space assigned in megabytes. This can
result in the megabyte and/or percentage numbers on your
screen not reflecting the absolute values on your fixed disk.
several logical drives are created in this way, the resulting
totals may be incorrect, leaving you with a “OMB” partition
size, or a partition size of less than 1%.

The DOS partition is now created, but before you can start your
system from t, you must set it as active. To do this:

. Press Esc to return to the FDISK Options menu.
2. Choose option 2. Set Active Partition.

3. Set the partition as active. Refer to "Setting the Active Partition
(Option 2)" on page 131.

4. Press Esc at the Set Active Partition menu to return to the FDISK
Options menu
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Creating an Extended DOS Partition

I you choose option 2. Create Extended DOS Partition from the
Greate DOS Partition or Logical DOS Drive menu, you see a screen
like this:

Create Extended 005 Partition
Current fixed disk drive: 1

Partition Status  Type Size inMbytes Percentage of Disk Used
1 A s ) £

Tota sk space s 12 Wytes (1 yte - 146570 ytes)
able for partition 15 90 Maytes (75%)

ntr arttonstan o tytes o prcn of dsk pce 1) to
4 005 Partition. 90

Press Esc to return to FOISK Options

Partition Is the drive letter and number assigned
to a DOS partition

Status Is the status of the partition—A for active.

Type Is the kind of partition—PRI DOS (primary
DOS) or EXT DOS (extended DOS).

Size In Mbyte: s the size of the partition in megabytes.

Percentage of Disk Used I the size of the pariltion in percentage
of total disk capacity.

It you want your extended DOS partition to be as large as possible,
press Enter. The default value is shown in megabytes and is the
maximum amount of contiguous space available on your fixed disk. If
You want to enter  different size, type the value you want in either
megabytes or percent; then press Enter.

It you create an extended DOS partition, you see a screen for creating
logical drives.



Creating Logical DOS Drives in the Extended DOS
Partition
f you create an extended DOS pa

ion, you see a screen like this:

Create Logical 005 Drive(s) i the Extended 005 Partition

Mo Togical drives defined

ot D 103 i ean 1 0 s Mt - 048 i)
Mximum space avatlable for logical drive 1s 90 Neytes (100%)

Enter Togical drive size in bytes or percent of disk space ()...[ %]

Press Esc to return to FOISK Options

To create a logical drive using the maximum space available, press
Enter. The default value is the maximum space available in mega-
bytes.

To create a logical drive in a different size
megabytes or percent; then press Enter.

nter the size you want in
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Setting the Active Partition (Option 2)

It you choose option 2. Set active partition from the FDISK Options
menu, a screen similar to this one appears. This example shows the
partition status of a fixed disk that has two partitions:

Set Active Partition

Current fixed disk drive: 1

Partition Status  Type Size in Mytes Percenta
e 1 A0S 30

of Disk Used
2%
z BT % i

Total disk space 15 120 Noytes (1 Noyte = 1048576 bytes)

Enter the nunber of the partition you want to make active: (1]

Press £sc to return to FDISK Options

Your fixed disk can have four partitions, but only one partition can be
active (startable) at a time. To start drive C, you need an active parti-
tion on the first fixed disk. (Although you may have an additional
fixed disk attached to your system, the partition you set as active
must be on the first fixed disk.) The active partition has control of
your system when started from the fixed disk.

To set an active partition:
1. Type the number of the partition that you want to be active.

If you want your DOS partition to be active, type the number for
the primary DOS partition. (An extended DOS partition cannot be
set as active.)

2. Press Entel

The partition you select becomes the active partition.
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Deleting a DOS Partition or Logical DOS Drive

(Option 3)

You can delete the fixed disk partition you use for DOS. When you

do, remember that any data in that partition is also deleted and

cannot be recovered. The boundaries for that partition are also

removed

Note: If you delete the primary DOS partition, but want to continue
using DOS on your fixed disk, make sure that you create a new
primary DOS partition before exiting FDISK.

It you choose option 3. Delete DOS Partition or Logical DOS Drive on
the FDISK Options menu, you see the following

Dellete 005 Partition or Logical 005 Drive

Current fixed disk drive: 1
Chose one of the folloving:
1. Delete Prisary 005 partition

2. Delete Extended D05 Fartition
3. Delete Logical DOS Drive(s) i the Extended 005 Partition

enter choice: ]

Press Esc to return to FOISK Options

Select the option you want by typing in the number; then press Enter.

N oW W N
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Deleting the Primary DOS partition
If you choose option 1. Delete Primary DOS Partition from the Delete
DOS Partition or Logical DOS Drive menu, you see this screen:

Delete primary 005 Partition

Current fixed disk drive: 1

Partition Status  Type Size in Mytes Percentage of Disk Used
1 A s % £

Total disk space 15 30 Moytes (1 Moyte » 1048576 bytes)

arnigt Dt o the deletd Primay 00 Prtiton i1 b lost.
50 you wish to continue. 7 00

Press Esc to return to FOISK Options

1, after reading the warning, you decide not to delete the DOS parti-
tion, press Enter or ESc to return to the FDISK Options menu. If you
want to delete the DOS partition, type Y (yes); then press Ente

1f you have an extended DOS partition, a displayed message informs
you that you cannot delete the. partition while an
extended partition exists. If you get this message, press ESc to return
to the FDISK Options menu and follow the steps to delete the
extended DOS partition, after which you can delete the primary DOS
partition.




Deleting the Extended DOS Partition
if you choose option 2. Delete Extended DOS Partition from the Delete
DOS Partition or Logical DOS Drive menu, you see a screen like this:

Dellte Extended 005 partition

Current fixed disk drive: 1

Partition Status  Type Size in Mytes Percentage of Disk Used
t1 A mIOS 30 2%

oros % 5
Total disk space 15 120 Moytes (1 Hoyte = 1048576 bytes)

Yarnirg Dat i the detad Extended 005 Pasion vl e st Do you
wish to continae. ?

Press Esc to return to FOISK Options

f, atter reading the warning, you decide not to delete the extended
DOS partition, press Enter or Esc to return to the FDISK Options.
menu

It you want to delete the extended DOS partition, type Y (yes); then
press Ente

If you have logical drives in the extended DOS partition, a displayed
message informs you that you cannot the extended DOS par
tion while logical drives exist. If you get this message, press Esc to
return to the FDISK Options menu. Follow the steps to delete the
Iogical drives in the extended DOS partition, after which you can
delete the extended DOS partition.
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Deleting the Logical DOS Drives in the Extended DOS

Partition

1f you choose option 3. Delete Loglcal DOS Drives In the Extended
DOS Partition from the Del DOS Partition or Logical DOS Drive
menu, this screen appears:

Dellate Logica 005 Drives in the Extended 005 Partition

O Youme ot teytes Sytem Ustge
SHITHA W nnz i

SPREADSHEET AT
mwic: B e
MORIEN Bonme

MORDPROCESS 6 FATIZ

Total Extended D05 Partition size 15 90 Maytes (1 Miyte = 1048576 bytes)
Marningl Data 1n a deleted Logical 005 Drive will be lost.

Wt drive do you want to delete? [ ]
Enter drive's volume Tabel [ !

Are you sure (1/N) (0]

Press Esc to return to FOISK Options

orv Indicates the drive letter that is assigned when the
system is restarted following exit from FDISK.

Volume Label Is the label given to the drive when it was formatted.

Mbytes Is the size of the drive in megabytes.

System Is the file system used to format the drive. FAT12
(file allocation table 12) is used for drives 16MB or
smaller; FAT16 is used for drives over 16MB.
“Unknown" is displayed if the partition has not been
formatted.

Usage Is the percentage of the extended partition used by
this drive.




The prompts appear in this order:

This is the first prompt that appears. Type in the letter of the drive
you want to delete; then press Enter.

This prompt appears after you have entered the drive letter in the.
previous prompt. Type in the volume label of the drive you want to
delete; then press Enter.

‘This prompt then appears with the warning. The default value is N
(no). If you want to delete the drive you have identified, type Y (yes)
over the N (no); then press Enter.

I other logical drives exist, this screen appears again to enable you
to delete them. When a drive is deleted, its status printout is
replaced by “x: drive deleted.”

If FDISK assigns new drive letters to the remaining logical drives, the
new drive letters are displayed when Esc is pressed. The drive
letters that appear are the drive letters that are assigned the next
time you start your computer.

A
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Displaying Partition Information (Option 4)

1 you chose option 4. Display partition information from the FDISK
Options menu, you see a screen like this:

Display Partition Information

Current fixed disk drive: 1
Partition Status  Type Size In Moytes Percentage of Disk Used
1 A mIos 3 5
2 Brws % i
Tota disk space 1s 120 Moytes (1 Moyte = 1048576 bytes)

e Extendes 05 Par o comtas Logical 05 rive
05 you want to display the Togical drive information (/0.7 Y]

Press Esc to return to FISK Options.

This screen shows how a fixed disk is partitioned.

1f you do not want to display the logical drive information, type N (no);
then press Enter. FDISK returns to the FDISK Options menu.



If you want to display the logical drive informat
following is displayed:

n, press Enter. The

Display Logical 05 Drive Information

v Yolume Lael eyt st e

0:' SHITHEA 10 PATi2
G Shose 4 o e
P sRemoter BT
G MRIEN ERTIT
W WROPROCESS 6 FZz 7k

Tota) Extended DOS Partition size 15 90 Moytes (1 Moyte = 148576 bytes)

Press £5c to return to ISK Options.

*Remote* Indicator
It you see the “*Remote*" indicator over a volume label, it means that
You have reused that drive letter to connect to a network drive.

I you want to disconnect this network drive from your system,
perform the following steps:

Exit FDISK.
2. Disconnect the network drive from your system. Refer to your
network documentation for the correct procedure.

Restart FDISK.

Selecting the Next Fixed Disk Drive (Option 5)

It you have another fixed disk to prepare, choose option 5. Select
Next Fixed Disk Drive from the FDISK Options menu. Note that the
“Current fixed disk dr value changes to “2." Proceed with these
'same steps to partition your second fixed disk drive.
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Appendix A. Messages

= This appendix contains messages associated with SELECT, listed in

T alphabetic order. The messages are in bold type; the cause and
action statements follow the message. Any other messages dis-

3 played during installation are complete as viewed.

'] Explanations for messages encountered while using FDISK, along

with any other messages you receive that are not listed her
found in Using DOS 4.00, Appendix D.

Incorrect DOS Version

Cause: SELECT. An attempt was made to run SELECT with DOS
version other than DOS 4.00.

Action: Insert the Install diskette in drive A; then press.
Ctri+Alt+Del to restart.

= Invalid Parameters on SELECT Command Line
3 Make sure the INSTALL diskette Is In drive
then press Ctrl + Alt + Del to rests
Cause: SELECT. SELECT was typed on the command line. The

the

= SELECT installation program cannot be started from t
command line.

Action: Insert the Install diskette in drive A; then press
Ctrl+Alt+Del to restart.

Invalid SELECT Boot Media

Insert the INSTALL diskette In drive A:, then retry
Cause: SELECT. An attempt was made to start SELECT from
other than drive A.

o Action: Insert the Install diskette in drive
) Ctrl + Alt+ Del to ret:

Invalld Disk/Disketto Media

Insert the INSTALL diskette in drive A:, then retry

then press

Cause: SELECT. An attempt was made to start SELECT from
media other than 360KB or 720KB.

a
e
o Action: Insert the Install diskette in drive
]

then press
Ctrl+ Alt+Del to retry.



An error occurred while Installing DOS
Press Enter to continue, or F3 to exit SEI.EC'I

Cause: SELECT. DOS has detected an error of undetermined
origin.

Action:  Press Enter to ignore the error or F3 to end installation.
Retry installation. If message persists, installation should be ter-
minated and the error source determined. If there is enough
space on your fixed disk for SELECT to install all the files and
DOS appears correct, run the diagnostics for your system. f the
cause of the error cannot be determined, contact your service
representative.
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